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Getting Started

Using This Manual

The FuelsManager Oil & Gas User manual explains how to use the FuelsManager Qil & Gas 7.5
SP4 suite of products.

Before reading this guide, you should become familiar with the operation of Microsoft Windows.
This manual is intended for system administrators, managers, engineers, and other top-level
management. A separate guide entitled Fue/sManager Oil & Gas 7.5 SP 4 Administrator Manual
is available for operators.

Windows Terminology

FuelsManager user interface is based upon the Microsoft Windows Graphical User Interface (GUI)
standard and is SAA-compliant (System Application Architecture standard for open systems). All
top-level menus, dialog boxes and mouse-driven interfaces adhere to the published standards
for Microsoft Windows. This manual uses the terms described in the following tables when
describing operator actions and windows elements for step-by-step instructions.

Actions in Windows

Actions Description

Point To move the mouse pointer until it rests on the item of
choice.

Click To quickly press and release the mouse button once.

Double-click To quickly press and release the mouse button twice in
succession.

Drag To hold down the mouse button while moving an object
across the computer screen.

Release To quit holding down the mouse button after dragging
an item.

Select To pick an item on a menu, button or to highlight text or

graphics usually via a single click). Selecting does not
initiate an action.

Choose To pick an item to carry out an action. Often needed to
select an item before choosing it (usually via a double-
click).

Varec, Inc.
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Window Elements

Elements

Description

Program Icon

Provides a pop-up menu, which allows window
modification.

Title Bar

Shows the title of the application, document or
FuelsManager graphic screen.

Menu Bar

Lists of available menus. Most applications have a File
menu, Edit menu, and a Help menu, as well as menus
unique to the application.

Menu

A menu contains a list of commands or actions
performed by the operator. Also referred to as a pop-up/
drop-down menu.

Dialog Box

A movable window that is displayed on screen in
response to the user selecting a menu option. It provides
the current status and available options for a particular
feature in the application.

Window

A scrollable viewing area on screen. May refer to the
entire application in a window.

Window Title

The Window title can be the name of an application,
document, group, directory or file depending on the type
of window in which it appears.

Close Button

Use this button to close the window or application.

Maximize Button

Use this button to enlarge the application window so that
it fills the entire desktop.

Minimize Button

Use this button to reduce the application window to an
icon at the bottom of the screen.

Restore Button

This button can restore an application window to its
previous size and location.

Window Border

The Window border is the outside edge of a window. The
user can change the window size by dragging the border
in or out on each side of a window.

viii
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1 Introduction

FuelsManager Oil & Gas is designed for operators of bulk storage facilities, marketing terminals,
refineries and pipelines and provides specific functionality for:

Tank gauging

Inventory management

Control and automation (SCADA)

Environmental compliance

Information management

Key Features

You can use FuelsManager Oil & Gas to monitor tank levels, temperatures, alarms, gross and net
standard volumes, and other data in real-time, for an unlimited number of tanks.

FuelsManager communicates with all major types of tank level and mass measurement
instruments, including float, radar, servo, hydrostatic, magnetostrictive and hybrid tank gauges.

If your system is configured for tank farm automation, you can access your facility’s
Programmable Logic Controllers (PLCs) through FuelsManager to control hydrant systems,
pipeline receipts, independent high level alarm systems, and Emergency Fuel Shut-Off (EFSO)
systems. PLCs are used to monitor and control tank farm instrumentation and control devices,
such as pumps and valves.

Key Tools

FuelsManager Operate
If you are a fuel facility operator, you will use this application to manage the fuel site.

To start: see “Starting FuelsManager Operate” on page 2
To use Operate: see “FuelsManager Operate Work Area” on page 3
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Introduction

Starting FuelsManager Operate

From the Windows Start menu, click All Programs > FuelsManager > Operate

Operate opens. The FuelsManager Operate window is shown below.

¥ FuelsManager - Operate

. FuelsManager

Display View Mlarm Poit Movements Tools Help

i e ~ B ) ) T T <
LA A D, R EFSOD
E = e & i AR o 3¢
: Historical Reports 8| 4px
# Graphics

W Tanks

% Static Tank Groups

4 Dynamic Tank Groups

;] Bl Automation solutions for oil & gas, defense and aviation applications

" | Historical Trends

|| Dynamic Reparts

9] Historical Reports

3] 01) Current Tank Inwertory Report 1

3] 02) Tank Invertory Report by Date 1

3] 03) Active Tark Report.rpt

3] 04) Inactive Tank Report rpt

3] 05) Last Full Day Tank Change Repa

3] 06) 7-Day Tank Change Repart.rpt

3] 07) Last Full week Tank Change Repy

3] 08) Last Full Morth Tark Change Re

2] 09) Morth to Date Tank Change Rep
< | >
¢ Alarm Line 2

T S =
Q i = (=] Newest UnAck
I -
D900 o H YTy
Ho UnAcknowledged Alarms
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2 FuelsManager Operate Work Area

FuelsManager Operate provides a powerful but intuitive interface for managing a tank facility.
This chapter describes the work area elements and how to change the work area to meet your
needs.

Work Area Elements

The Operate window elements are shown below.

Window Tab Icon Toolbar Tabbed Window Display

# FuelsManager - Operate
Menu Bar —Display View Alarm Point Mofements Tools Help

AhE R NIRRT g0 o &8O D]
: Historical Reports ~ # 87| arx

Task Group f\’z?;:ius

Set 7 Static Tank Groups
%> Dynamic Tank Groups
[%] Historical Trends

] Historical Reports Automation solutiens for oil & gas, defense and aviation applications

FuelsManager
DEFENSE

Task Group —]

2] 02) Tank Inventory Report by Dats
%] 03) Active Tank Report rpt

3] 04) Inactive Tank Report.rpt

2] 05) Last Full Day Tank Change Re|
3] 06) 7-Day Tank Change Report i
3] 07) Last Full wesk Tank Change §
3] 08) Last Full Mionth Tank Change
3] 03) Month to Date Tank Change Rs

< | B
=] Realtime Trends
| | Dynamic Reports

Alarm Line ——. @Q @' %?2 “* NO ACTIVE ALARMS **

Ready Lawrence 10/9/2006 2:26:55 PM NUM

Status Bar

The Alarm line illustrated above is the default alarm line. Your system administrator may have
enabled the alternate Alarm line. More information on the alternate Alarm line is available at
“Using the Alternate Alarm Line” on page 19.

FuelsManager Operate supports up to 4 monitors. Your system manager can help you configure
your monitors if the appropriate hardware and software has been installed.
Viewing Tabbed Window Displays

FuelsManager Operate presents information about your site in tabbed window displays on the
right side of the Operate window. In Operate, these are also referred to as ’'views’.
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FuelsManager Operate Work Area

You can open a single tabbed windows display, such as a tank group screen that you must
monitor constantly. Or you can open multiple tabbed windows and quickly switch between them
to monitor different types of information.

Opening a Tabbed Window Display

You can open tabbed window displays by selecting options from the menu, the toolbar, task
groups, or by using a keyboard shortcut.

Closing a Tabbed Window Display

Click the X symbol on the right side of the window tab bar.

Selecting a Tabbed Window Display

If the tabbed window display that you need is opened but obstructed by other windows,
click on the its window tab for the desired window.

Closing All Tabbed Window Displays

On the menu, select View > Close All Views.

Working with Task Groups

Task Groups provide a way to choose data views quickly. They can be moved to different sides
of the Operate window, grouped together, arranged separately, or hidden from view. This
section describes how you can set up task groups in Operate to fit your needs.

Moving a Task Group or Task Group Set

1. Click and hold on the title bar of the task group or task group set.

i Historical Reports N 1
g‘ Graphics i
W) Tarks

5 Static Tank Groups

.'7"-‘ Dynamic Tank Groups
<<|Realtime Trends
"i] Historical Trends
|| Dynamic Reports
:ﬂ Historical Reports

3| 01) Current Tank Invertary Report ry
3] 02) Tank Inventory Report by Date .y

2. Drag the mouse pointer to a different side of the monitor until a grey rectangle appears.

3. Release the mouse button.

Forming a New Task Group Set

1. Place one task group in the desired location, as described above.

2. Click and hold the next task group and drag it over the title bar of the first task group. A
rectangle border with a tab should appear.

3. Release the mouse button.
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Note If the task groups were not placed into a set, perform steps 2 - 3 steps again and be
sure that a rectangle with a tab appears before you release the mouse button.

Rearranging Task Groups in a Set

1. Click and hold on the task group title bar.
2. Drag the task group vertically to the desired location.

3. Release the mouse button.

Adding a Task Group to a Set

1. Click and hold the title bar of the task group that you want to move.

2. Drag the task group over the task group set title bar. A rectangle border with a tab should
appear.

3. Release the mouse button.

Note If the task groups are not placed into a set, perform steps 2 - 3 steps again and be
sure that a rectangle with a tab appears before you release the mouse button.

Stacking Isolated Task Groups

Use this technique to position isolated task groups vertically on one side of the display, but not
in a set.

1. Click and hold the title bar of the task group that you want to move.

2. Drag the mouse pointer just under the title bar of the target task group. A simple rectangle
border (without a tab) should appear.

Dynamic Reports k

a tank - ks - Inactive

_‘ currinventary - Current Inventory - In
_‘ inactivetank - Inactive Tanks - Inactiv
_‘ operatingtank - Operating Tanks - Ina

< >

i Historical Reports 1
~ 01) Current Tank Invertory Report rpb
“3] 02) Tark Inventory Report by Date 1

=3 ] 03) Active Tank Report ot
“1] 04) Inactive Tank Report rpt

3. Release the mouse button.
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FuelsManager Operate Work Area

Minimizing a Task Group or Task Group Set

You can save screen space by reducing a task group or task group set to an icon in the window
border.

+ Click the thumbtack icon in the task group or task group set title bar.

i Historical Reports @\
g‘ tGraphics

W) Tanks

7 Static Tank Groups

‘g:j. Dyenamic Tank Groups

~=| Realtime Trends

(& Historical Trends

|| Dynamic Reparts

“’ﬂ Historical Reports

"3 01) Current Tank Invertory Report.r
02) Tank Inventary Repart by Date
03) Active Tank Report.rpt

04) Inactive Tank Report rpat

05) Last Full Day Tank Change Repol
06) 7-Day Tank Change Report rpt
07) Last Fullvieek Tank Change Rep|
08) Last Full Month Tank Change Rey
09) Month to Date Tank Change Repg

« The task group or task group set goes out of view; it is indicated by a tab on the browser
border.

¥ FuplsManager - Operate

Display  Wiew Alarm  Point  Moveme

Dk

[

spodday eaL03EH |_5:

Using Minimized Task Groups

1. Position the mouse pointer over the icon for the task group or task group set, as shown in
Figure . The task group or task groups slide into view.

¥ FuelsManager - Operate

Display Wiew Alarm  Point  Movements Te

Rt

i Historical Reports -+

%] 01) Current Tank Inwentory Report.re =
| 02) Tark Invertory Report by Date ¢
.| 03) Active Tank Report.rpt

.| 04) Inactive Tank Repart.rpt

3| 05) Last Full Day Tank Change Repo
06) 7-Day Tank Change Report.rat

4| 07) Last Full'vWeek Tank Change Reg
4| 08) Last Full Monith Tank Change Rep
3] 09) Morith to Date Tank Change Repe |y

g reavorsiH [ [ [[A1][A)] %
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2. Click the appropriate item in the task group.

Restoring Minimized Task Groups

1. Position the mouse pointer over the icon for the task group or task group set. The task

group or task groups slide into view.

2. Click the thumbtack icon % in the task group or task group set title bar.

Using the Toolbar

Selecting an Option from the Toolbar

On the toolbar, select the appropriate icon. The icons are described in the table below.

Note Some options may not be available on the toolbar, or they may have been temporarily
removed. To see all the toolbar options, see “Adding or Removing Toolbar Buttons” on

page 8.
Icon Description Icon Description Icon Description
m Tank Details % 11 Historical Trends 1-3 Leak Detection
a o
o Tank Group = Movement % | Tank Historical Trend
27 History T/ *1
= Graphics ™3 Movement Tank Realtime Trend
@ Summary l > “j
Dynamic Reports Alarm Summary e Point Define
I e M
||'L_|-;_—_:—" ||L'.ih_—__ //’" =:E_‘|x
Historical Reports é Alarm Log - Print Screen
Realtime Trends l_"" Tank Calculator Macro

Help

About

Changing the Size of the Toolbar Buttons

On the menu bar, select View > Toggle Icon Size.

Hiding or Showing the Toolbar

On the menu bar, select View > Toolbar.
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Adding or Removing Toolbar Buttons

1. Click on toolbar options bar on the end of the Toolbar.

2. Select Add or Remove Buttons > Standard. A checklist appears showing all of the available
command buttons.

3. Select the checkbox for each button to show on the toolbar. Clear the checkbox for each
button to remove from the toolbar.

Resetting the Toolbar to Default Settings

If you have removed buttons from the FuelsManager Operate toolbar, but prefer to show all
toolbar options again, perform the following procedure.

1. Click on Toolbar Options bar on the end of the Toolbar.

fidd or Remave Butkons - | Standard 2 | [v] W] TankDetai
| z '.,.‘-;3 Tank Group
| | ',g Graphics
z -_: [rynamic Reports
z 3 Historical Reparts

~| Realtime Trends

5 Historical Trends
@d Movement Summary
.,JJJ"' Movement History

y
‘g Alarm Summary

[<I<T<<

g, Alarm Log
—= Tank Calculator
3§ Lesk Detection

Tank Historical Trend

[<1<]<]
'

5 Tank Realtime Trend
ol Poink Define
é-.-) Print Screen
@ Macro
o
)

Help

[l <]

About

Reset I |
40

2. Select Add or Remove Buttons > Standard > Reset.

Error Messages

The table below contains the error messages that you may see if there is a problem with
FuelsMAnager.

Icon Description
The graphic element is not in the expected format. Operations should
Mggm;ta;h contact System Administrator to correct this issue.

The value is mapped to a data source but no data has been provided since

it g the system was initialized. If the data source is manual entry an operator
simply need to set the value.
CommManager failure. The data source for this value is a CommManager
10 point and the given CommManager is unreachable.
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Icon

Description

The data source for this value is available and communicating. The value
being provided is being filtered from the operators view because the
upstream device is not communicating to the data source or a status for
the given value is indicating the value may be invalid.

Hot
Connected

The data source for this value is CommManager. CommManager is
functioning normally but the communication interface where this comes
from is not active.

The DataManager system that manages this data point is not reachable.

Restricted
User Account

The current user is not permitted to view this data.

Invalid

The point referenced in Operate is not valid.

Disabled

The point this value comes from is disabled in the system.

OPC Fail

The data source for this value is an OPC Server that is not reachable. A bad
OPC tag quality from the OPC server can result in an 10 Fail.

Hiding or Showing the Status Bar

On the menu, select View > Status Bar.

Note A check in the checkbox indicates that the bar is currently visible.

Using Online Documentation

On the Operate menu, click Help to access documentation, as described in the following table:

Menu Option

Description

Help

Table Of Contents

Opens this manual in Adobe Acrobat® for online
reference at the ‘Table of Contents’ section.

Movements

Opens this manual in Adobe Acrobat® for online
reference at the ‘Using Product Movement’
section.

For Beginners

Opens this manual in Adobe Acrobat® for online
reference at the ‘Using This Manual’ section.

Menu Commands

Opens this manual in Adobe Acrobat® for online
reference at the ‘Operate Window Elements’
section.

Alarm System

Opens this manual in Adobe Acrobat® for online
reference at the ‘Alarm Tools’ section.

Using Operate

Opens this manual in Adobe Acrobat® for online
reference at the ‘Getting Started with Operate’
section.

Keyboard Shortcuts

Opens this manual in Adobe Acrobat® for online
reference at the ‘Keyboard Shortcuts’ section.
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Keyboard Shortcuts

Key

Action

F1

Displays the Index Display graphic view.

F2

Opens the Graphic Display Selection window.

F3

Opens the Report List Selection.

F4

Opens the Database Point Monitor for a
previously defined point.

F5

Displays the Alarm Summary.

F6

Silences alarms.

F7

Opens a Tank Detail screen.

F8

Opens a Tank Group.

F9

Toggles between Graphic and Tabular Tank
Group displays.

CTRL+F4

Closes the selected window.

CTRL+F6

Toggles between all open tabbed displays.

(CTRL+Tab)

Toggles between all open tabbed displays.

ALT+Tab

Toggles between all open Windows applications.

Page Up

Displays the Tank Detail for each tank in the

Page Down

system, in sequence, when a Tank Detail window
is the active window.

Command Summary

Menu Option

Description

Display

Index Display (F1)

Opens the index display view.

Open

Displays a submenu listing view options.

Print Display

Prints the current window.

W&M Tag Seals

Shows the seal status for Weights & Measures
- approved tanks.

Communications

Shows the communications status of all
Operate screens. For diagnostic purposes
only.

Exit Operate

Exits the FuelsManager Operate application.

View

Toggle Window Tabs

Moves views tabs to top or bottom of view(s).

Toolbar

Shows or hides the toolbar.

Status Bar

Shows or hides the status bar.

Toggle Icon Size

Switches the size of the toolbar icons from
small to large or large to small.

Close All Views

Closes all open views.

Use Tank Description

10
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Menu Option Description

Tools Macro Opens the Macro window for recording or
playing back sequences of actions and
commands.

Perform Leak Rate Analysis | Opens the Perform Leak Analysis window for
performing analysis of sensor data for
conditions that might indicate a leak.

Point Define Allows you to select a Database Point to
monitor.

Open Restore (F4) Opens/Restores the Database Point Monitor.

Close Window Closes the Database Point Monitor.

Minimize Minimizes the Database Point Monitor.

Window Window | Calculations (Only available when a Tank Detail screen is
open).Allows you to perform and print 'What
if’ calculations.

Help Table Of Contents Opens this manual in Adobe Acrobat® for

online reference at the ‘Table of Contents’
section.

Movements

Opens this manual in Adobe Acrobat® for
online reference at the ‘Using Product
Movement’ section.

For Beginners

Opens this manual in Adobe Acrobat® for
online reference at the ‘Using This Manual’
section.

Menu Commands

Opens this manual in Adobe Acrobat® for
online reference at the ‘Operate Window
Elements’ section.

Alarm System

Opens this manual in Adobe Acrobat® for

online reference at the ‘Alarm Tools’ section.

Using Operate

Opens this manual in Adobe Acrobat® for
online reference at the ‘Getting Started with
Operate’ section.

Keyboard Shortcuts

Opens this manual in Adobe Acrobat® for
online reference at the ‘Keyboard Shortcuts’
section.

About Operate

Opens the About FuelsManager window.

Varec, Inc.
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Managing Alarms

An alarm is a notification that something has occurred in the fuel system at your tank facility
that may require your immediate attention. This could include, for example, a product level
approaching the high limit, or a field instrument communications failure.

At installation, your administrator makes a decision about whether the default alarm line or the
alternate alarm line is used. The presentation of alarms for each of these alarm lines is different,
however, the function is the same—to present information regarding conditions that may
require your intervention. The default alarm line is discussed beginning on page 16 and the
alternate alarm line is discussed on page 19.

This chapter describes how to respond to alarms and how to review the alarm history (log) for
a particular day.

Managing Alarms - Overview

Managing alarms with FuelsManager consists of:

Responding to new alarms: “Responding to Alarms” on page 15.
Reviewing the Alarm Log: “Using the Alarm or Event Log” on page 22.
Add a comment to the Alarm Log: “Using the Alarm or Event Log” on page 22.

For detailed Alarm Line instructions, see page 16. To use the Alarm Summary, see page 18.

How FuelsManager Indicates Alarms

If FuelsManager Operate is Visible
When an alarm occurs in your facility and the Operate window is open:

An audible tone sounds at your PC. The type of tone corresponds to the alarm priority: the
higher the pitch, the higher the priority.

The Alarm Indicator lens flashes the appropriate alarm color (for example red or yellow).

The tank alarm on the next page shows the default alarm line.

Varec, Inc. 13
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Graphic /
Data Field
Flashes

The example below shows a similar alarm using the alternative alarm line.

@%@@@3@5@@% Do

Tig‘g.ﬁ@@!

| Static Tank Groups
W) Tanks
# Graphics
) Static Tank Groups

)7 EastTank Group
%7 West Tank Group

55 Dynamic Tank Groups
& Historical Trends

] Historical Reports
<] Realtime Trends
|_] Dynamic Reports

> West Tank Group

# FuelsManager - Operate

Display View Alrm Point Movements Tools

1:44 PM  TankFarm.Tank 12.TanK

Tank 10 Level

Regdy

|Lawrence

|10/9/2006 3:45:16 PM [ Inum

Alarm

Alarm

Level Bar
Colored Red

Alarm

Buttons and/or other objects flash the assigned alarm color. At your facility, this could
include flashing text or graphics.

For example, the Hi alarm setpoint for a tank will flash in the Tank Detail and Tank Group
window (shown above) if there is a Hi level alarm for that tank.

The status field in the Alarm Summary flashes. See section on page 18 for Alarm Summary
information.

The alarms and events are logged to a disk file.

asagFamrreaf

Date & Time Tag Description Variable System Alarm Text Alarm Comment Categary Priority Status
12/31/1969 7:00:00 PM | Tank Farm.Additive. 112, TankPt | Tank 113 Level WSER-1552-TLSRE Default 02 LowLows
12/21/1860 7:00:00 FM |RadcEthanol.Loop 1.Unauth FI Frocess Value WSER-1552-TLERG Default oz
12/31/1969 7:00:00 PM |Rack Ethanal.Loap 2.Unauth FI.. Process Value WSER-1552-TLSRE Default 02
12/21/1868 7:00:00 FM |RadcEthanol.Loop 3.Unauth FI Frocess Value WSER-1552-TLERG Default oz
12/31/1969 7:00:00 PM |Rack Ethanal.Loap 2.Unauth FI.. Process Value WSER-1552-TLSRE Default 02
12/21/1860 7:00:00 FM | Tank Farm Additive 100 TankPt | Tank 100 Lewel WSER-1552-TLERG Default oz
1263111969 7:00:00 PM | Tank Farm.Additive. 105 TankPt | Tank 108 Level WSER-1552-TLSRE Default 02

14
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If FuelsManager Operate is Minimized

When an alarm occurs and the Operate window is minimized:

An audible tone sounds at your PC. The type of tone corresponds to the alarm priority, that
is the higher the pitch, the higher the priority.

A pop-up window appears in the lower right corner of the display. Click the alarm
description to show the Operate window.

Responding to Alarms

FuelsManager constantly monitors your fuel system to check for errors or other conditions that
may require your intervention. If such an event occurs—such a tank level reaching a high-level
mark—FuelsManager changes the status of the affected item, which triggers an alarm. There are
four status levels, as shown in the table below.

Name Description On Alarm On Alarm
Line Summary
Unacknowledged Operator has not acknowledged the alarm or
" Yes Yes
Alarm cleared the alarm condition.
Acknowledged Operator has acknowledged the alarm, but has not
T No Yes
Alarm cleared the alarm condition.
Unacknowledged Operator has cleared the alarm condition, but has
Yes Yes
Normal not acknowledged the alarm.
Acknowledged The value for this piece of information is within
-~ No No
Normal acceptable limits.

Generally, when an alarm occurs, you need to:

1.

Silence the alarm (see below). This turns off the audible tone but does not change the alarm
state.

Find out why the alarm occurred (see “Viewing Alarm Details”).
Acknowledge the alarm (see “Acknowledging Alarms”).

Resolve the issue that caused the alarm. This clears the alarm and returns the status of the
data point to Acknowledged Normal.

Silencing Alarms

To silence and acknowledge the alarm at the same time:

Acknowledge the alarm, see “Acknowledging Alarms”.

To silence all alarms before acknowledging them, do one of the following:

Press F6.

On the Alarm menu, click Silence.

On the Alarm Line, click the Silence button.

On the Alarm Summary view toolbar, click the Silence button.

Refer to “Using the Default Alarm Line” on page 16 for default Alarm Line information and refer

to

“Using the Alarm Summary” on page 18 for Alarm Summary information.

Varec, Inc.
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Viewing Alarm Details

For a tank alarm, do one of the following:

On the Alarm Line, click the Tank Details button.
On the Alarm Summary view toolbar, click the Tank Details button.

Refer to see section on page 16 for default Alarm Line information and refer to “Using the Alarm
Summary” on page 18 for Alarm Summary information.

The Alarm Details text on the Alarm Line shows key information for the current alarm.

Acknowledging Alarms

To acknowledge alarm(s), do one of the following:

On the Alarm menu, click Alarm Line > Acknowledge.
On the Alarm Line, click the Acknowledge button.
On the Alarm Summary view toolbar, click the Acknowledge button.

This method acknowledges all alarms displayed in the Alarm Summary view.

Refer to “Using the Default Alarm Line” for Alarm Line information and refer to “Using the Alarm
Summary” on page 18 for Alarm Summary information.

FuelsManager tracks information for many different aspects of your fuel system. Each item of
information is called a data point. Regarding alarms, each data point has four possible states,
as listed in the table below.

Name

Description

Shown On

Unacknowledged
Alarm

Operator has not acknowledged the alarm,
and the alarm condition has not been
cleared

Alarm Line and
Alarm Summary

Acknowledged Alarm

Operator has acknowledged the alarm, but
the alarm condition has not been cleared

Alarm Summary

Unacknowledged
Normal

The alarm condition has been cleared, but
the operator has not acknowledged the
alarm.

Alarm Line and
Alarm Summary

Acknowledged
Normal

The value for this piece of information is
within acceptable limits (it is not in the
alarm condition).

Not shown. Not an
alarm.

Using the Default Alarm Line

The default Alarm Line, shown below, is a graphical tool for managing alarms. You can use the
Alarm Line to monitor, acknowledge, silence, and to obtain more information for each alarm.

16

User Manual



FuelsManager Oil & Gas

Alarm Tank
Graphic Details
Acknowledge
Alarm
a; 4 S, 10/9/2006 2:41:44 PM Trml-:Farm.Tank 12.Tank
Alarm Lens & Silence Alarm
Alarm Summary Alarm Details

Default Alarm Line Features

The following table describes each of the buttons on the default Alarm Line, and the Alarm Lens,
which show alarm status.

Button / Text Description

Alarm Lens & Alarm Shows the priority level of the highest-priority active alarm in the system.
Summary Click to display the Alarm Summary.

Acknowledge Alarm Silences the alarm shown; changes the alarm state to “acknowledged”;
records the alarm in the alarm log as acknowledged.

Silence Alarm Silences all audible alarms

Alarm Graphic Shows the graphic assigned to the currently displayed alarm, if a graphic
was assigned to the alarm.

Alarm Help Shows help text associated with the currently displayed alarm if help was
assigned to the alarm.

Tank Detail Visible only if the alarm pertains to a tank. It is used to activate the Tank
Detail associated with the alarm.

Alarm Details (text Shows the date, time, and other information about the current alarm.

only)

Checking the Alarm Status on the Default Alarm Line

The current alarm status depends on the database value. For example, if a tank level alarm
becomes active, this line would display a status, such as Low or High-High. The alarm status is
also indicated by the color shown for the alarm.

Alarms appear in the order in which they occur.

Color Description
Flashing color Unacknowledged active alarm
Flashing green Alarm has returned to normal, but has not been

acknowledged

Blue No alarms are present.

Alarm Information

When an alarm is present, the line displays the information shown in the table.

Varec, Inc. 17
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Note The format for Time and Date information is determined by your computer’s
Regional Settings.

Element Description Format

Time The time of day the alarm occurred - HH:MM:SS

expressed in the format: (Hour, Minute, Second).

Date The date the alarm occurred - MM/DD/YY
expressed in the format: (Month, Day, Year).

Database Point | The name as it appears in the database
(Tank_34 Gauge) and the
corresponding variable (Level)

Alarm Status The database points alarm condition,
examples include: Disconnected, High-
High and Movement Alarm.

Using the Alarm Summary

You can use the Alarm Summary, shown below, to manage active alarms and to respond to new
alarms. The Alarm Summary shows all active alarms in a single list.

Alarm Summary Alarm Summary
Toolbar List with Details

# FuelsManager - Operate.

Dispay View Abrm Pont Movement] Toos Edit Hep

T SRR P IR Ry Y8 e XX | Order of

{ static Tank Groups ~ # % West Jank Group” 3 4bx Selected
W Tanks f System:\DLAWRENCE Selected  30f 4
— XY T

Alarm
ink Groups Date & Time. | Tag. Description. & Variable | Status
i 10/10/2006 3:42:13 PM |TankFarm Tank 13 Tank Tank 13 Level
10/10/2006 3:34:37 PM | TankFam Tank 13.Tank Tank 13 Level |Low
Alarm
10/9/2006 3:49:42 PM_[TankFarm.Tank 16 Tank Tank 13 Level
Status and
Priority

% Dynamic Tank Groups
] Historical Trends

5] Historical Reports
~|Realtme Trends
__| Dynamic Reports

. @Q & %E\) 1011012006 3:42:13 PM TanIFann.Tank 13.Tank Tank13 Level

Reddy
I

Alarm Lens Alarm Line
(Opens Alarm
Summary)

Lawrence  [10/10/2006 4:38:23 PM NUM
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Displaying the Alarm Summary

Press F5.

On the Alarm menu, click Summary > Open/Restore.
On the Toolbar, click the Alarm Summary button.

On the Alarm Line, click the Alarm Lens.

Viewing Alarm Details Using the Alarm Summary
The Alarm Summary lists all active alarms, with the most recent alarm at the top of the list.
The following information is provided for each individual alarm:

Time & Date (e.g. 11:14:51 02/21/96)
Tag, Description & Variable (e.g. Site_34.Tank121.GAUGE, Site 34 Tank 121, Temperature)
Alarm status (e.g. Low-Low)

To view alarms
1. Select an alarm in the summary list, and then do one of the following:

For tank points, click the Tank Detail button. The Tank Detail screen appears and the
affected data field will be highlighted in the designated color for that alarm condition.

For input/output points, click the Alarm Graphic and/or Alarm Help button, to see the
custom graphic and/or the Help file for this point.

Using the Alarm Summary Toolbar

You can use the toolbar in the Alarm Summary window to manage alarms. This toolbar includes
many of the buttons available on the Alarm Line. See “Using the Default Alarm Line” on page 16
for more information.

Select an alarm in the Alarm Summary list before you click a button on the toolbar.

Note Clicking the Silence Alarm button on the Alarm Summary toolbar silences all alarms,
not just the alarm selected.

Using the Alternate Alarm Line

The alternate Alarm Line is selected at installation by the administrator. The alarms are
presented in a format similar to a spreadsheet and it contains more detailed information than
the default Alarm Line. You may need to scroll left or right to view all the details of the alarm.

Note If you hover the mouse over a cell that is partially obscured, the entire contents of
the cell appears as a tooltip.

An example of the alternate Alarm Line appears below.

aoaFumrraz]

Date & Time Tag Description Variable System Alarm Text Alarm Comment Categary Priority Status
12/31/1969 7:00:00 PM | Tank Fam.Additive. 112 TankPt | Tank 113 Level WSER-1552-TLSRE Default 02
12/21/1860 7:00:00 FM |RadcEthanol.Loop 1.Unauth FI Frocess Value WSER-1552-TLERG Default oz
12/31/1969 7:00:00 PM |Rack Ethanal.Loap 2.Unauth FI.. Process Value WSER-1552-TLSRE Default 02
12/21/1868 7:00:00 FM |RadcEthanol.Loop 3.Unauth FI Frocess Value WSER-1552-TLERG Default oz
12/31/1969 7:00:00 PM |Rack Ethanal.Loap 2.Unauth FI.. Process Value WSER-1552-TLSRE Default 02
12/21/1860 7:00:00 FM | Tank Farm Additive 100 TankPt | Tank 100 Lewel WSER-1552-TLERG Default oz
1263111969 7:00:00 PM | Tank Farm.Additive. 105 TankPt | Tank 108 Level WSER-1552-TLSRE Default 02

The icons at the top of the alternate Alarm Line are shown below with a brief description.
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Icon Name Description

Multiple Acknowledge Allows you to acknowledge all visible alarms in
the current view at one time.

Single Acknowledge Allows you to acknowledge the selected alarm.
Silence Silence all audible alarms.
Alarm Graphic Provides a link to any alarm graphic associated

with the triggered alarm.

Alarm Help Provides a link to any alarm help associated with
the triggered alarm.

Tank Detail Provides a link to the tank detail associated with
the triggered alarm.

Filter Allows you to filter alarms. See “To use the filters
- on the alternate alarm line:” on page 21.
Clear Filter Clears any filters that were previously set.
L
Clear Sort Clears any sort previously used.
s
Toggle Icon Size Toggles the alarm icon bar from large icons to
small icons.

-

The columns in the alternate Alarm Line appear in the following table. All columns can be sorted,
but only the 5 can be filtered.

Heading Description Sort? Filter?
Date & Time Date and time the alarm sounded. Yes No
Tag Tag description associated with the alarm. Yes No
Description This is the description entered for the tank point for Yes No
which the alarm was triggered.
Variable Point variable that generated the alarm. Yes Yes
System Server associated with the alarm. Yes Yes
Alarm Text Customer configured alarm text. Yes No
Alarm Comment Comments that operators can enter. See “To enter alarm | Yes No

comments:” on page 22.
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Heading Description Sort? Filter?

Category The alarm category, for instance, Control Room 1, Yes Yes
Control Room 2.

Priority Alarm Priority Yes Yes

Status Alarm Status, see the table below of a description of the | Yes Yes

Status colors

When an alarm condition is detected by FuelsManager, it appears in the alternate alarm line. The
following colors provide a visual representation of the severity of the alarm. The colors below
are typically used by Varec customers, however the colors are configurable by the customer.

Color Description Priority
Blue, flashing Unacknowledged 3, Highest
Blue, solid Acknowledged 3

Red, flashing Unacknowledged 2

Red, solid Acknowledged 2

Yellow, flashing (?) Unacknowledged 1

Yellow, solid Acknowledged 1
Magenta, flashing Unacknowledged 0
Magenta, solid Acknowledged 0

Green, flashing Unacknowledged alarm that has cleared itself.

To acknowledge an alarm:
1. Click the alarm you want to acknowledge.

2. Click the Single Acknowledge icon and the alarm stops flashing.

To acknowledge all visible alarms:
1. Click the multiple acknowledge icon.

To silence an alarm:
1. Click the Silence icon. All alarms sounding are now silenced.

To resize the alternate alarm line:

1. Hover over the upper border of the alternate alarm line where the cursor turns into the
resize cursor.

2. Click and move the border where you want it.

Note You cannot move it to more than half of the available window.

To use the filters on the alternate alarm line:

1. Click the Filter icon on the alternate alarm line toolbar and the Alarm Line Filter Setup win-
dow opens as shown below.
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Alarm Line Filter Setup

Column

Available Filkers Selected Filters
Selections I Column I Filter Item I
Unacknowledged

Acknowledged
Marmal

=

=<

) bkt

o] Cancel |

2. Select the column you want to filter on in the Column list. When you select the column, the

choices for that column appear in the Available Filters list.
3. Select the appropriate filter (using the Ctrl key to select multiple filters).
4. Click the right arrows to move them to the Selected Filter list.

5. Click OK and the alarm line is displayed with the designated filters.

Note Use the left arrows to remove any filter criteria, if needed.

To remove filters applied to the alternate alarm line:
1. Click the Clear Filter icon on the alternate alarm line toolbar.

To enter alarm comments:

1. Double-click in the Alarm Comments field for the corresponding alarm.

2. Type in your comment in the comment field.
Note Comments are limited to 254 characters including spaces.

To increase or decrease the size of the font in the alternate alarm line:

1. Right-click in any cell on the alternate alarm line.

2. Click Increase or Decrease to change the font size as appropriate.

To reorder the columns on the alternate alarm line:

1. Click the column heading and drag the column where you want it to appear.

2. Release the mouse button and the columns reorder.

Using the Alarm or Event Log

You can use the Log File Browser to view and print all the alarms, events or a combination of

both for any selected day.

22
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Viewing a Log File

Select the appropriate database system, date and the log type (Alarm, Event or Combined).

Click Open. The Log File Browser window shows the alarms, events, or alarms and events

1.
2.
that occurred on the selected day.
Log File Browser
Log Files To Open Current View
Database Selection —~ System: [wrmE - el
" Event Log
Date Selection — Date: |August | EI Zﬂﬂﬁkji  Combined

Open
Close
[ e | Print, add

Day Displayed: |Augus12, 2005 on system WFME

View Selection

—-+— Open, Close,

Comment

8/2/2005 10:56:04 AM  TankFarm. Tank 12.Tank Tank 12
= High-High Level = 40.00-00 ft-in-16th)

8272005 10:56:04 AM  TankFarm.Tank 12.Tank Tank 12
i High Level = 40-00.00 {ft-in-16th)

8/2/2005 10:56:18 AM  TankFarm.Tank 12.Tank Tank 12
Acknowledge High-High Level, By : Administrator

8/272005 10:56:40 AM  TankFarm.Tank 12.Tank Tank 12
Acknowledge High Level, By : Administrator

8/2/2005 10:56:54 AM TankFarm.Tank 12.Tank Tank 12
Normal High-High Level

Alarm or Event
Information

8/2/2005 10:56:54 AM  TankFarm.Tank 12.Tank Tank 12
Hormal High Level

8/2/2005 3:55:22 PM TankFarm.Tank 12.Tank Tank 12
= High-High Level = 40-00-00 {ft-in-16th

Alarm Information

Alarms may contain the following information:

New alarm state

Tag and description of database point
Time and date of occurrence

Priority of alarm

Event Types

Events may be of the following types:

New tank setpoints
Tank status changes
Tank mode changes
Operator-entered data

Event Information

Events may contain the following information:

Present status

Tag and description of database point
Time and date of occurrence

Event type and identification

Printing an Alarm or Error Log File

1.
2.
3.

View the log for a particular day as described in “Viewing a Log File” on page 23.

If you want to print part of the log file, select the log information that you want to print.

Click the Print button.

Varec, Inc.
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4. Select the page range, the number of copies and the desired printer.

5. Click OK.

The hard copy contains all the information as displayed in the Log File Browser window. The
page number and sequence (for example ‘2 of 5’ pages) is found at the bottom-center of each

page.

Adding Comments to Log Files

You can add comments to a particular alarm, event or both by using the Comment feature, which
displays text (60 characters maximum) immediately below the alarm or event. If more than 60
characters are required, the system allows multiple comments to be associated with a single
alarm. You cannot delete comments after they are entered.

To add a comment to a log file entry

1. View the log for a particular day as described in section section on page 23.

2. Click the Comment button. The Add Comment window opens.

Add Comment

Currert Selsction
Time: 06/02/2005 10:56:40
Tag TarkFarm. Tark 12 Tark
Stater  Acknowledge

Comment

3. Enter your comment.

4. Click OK.

Command Summary

Command

Description

Alarm Silence (F6)

Silences the current alarms

Alarm Line

Displays a submenu of Alarm Line
commands

Alarm Line

Acknowledge

Acknowledges the alarm shown in
the Alarm Line

Alarm Graphic

Opens the graphic associated with
the currently selected alarm.

Summary

Displays a submenu of Alarm
Summary commands

Open/Restore (F5)

Opens/Restores the Alarm Summary
window

Close Window

Closes the Alarm Summary window

Show Log File Browser

Opens the Log File Browser window

24
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4 Managing Individual Tanks

FuelsManager Qil & Gas software provides tools for working with an entire tank farm, or with
individual tanks. This chapter describes how you can manage individual tanks in FuelsManager

Understanding Tank Details

To manage a facility, you must be able to obtain information about each tank. FuelsManager
shows you this information in a Tank Detail window.

Tank Detail Fields

The following pages explain the meaning of the standard fields shown on a Tank Detail window.
Because the Tank Detail template is configurable, the Tank Detail may look different depending
on the facility’s requirements. In addition, FuelsManager can use a different Tank Detail

template for different types of tanks, so the Tank Detail fields may differ depending on the tank
selected.

Note Please refer to the “Tank Detail Field Descriptions” on page 29 for a complete
description of Tank Detail fields.

Viewing Tank Details for a Single Tank

Note Multiple ‘“Tank Detail’ windows can be opened using any of the methods listed below.

Press ‘F7’ key on the keyboard. The Select Tank Point window appears. Select a tank and
then click Select.

Open the Tanks task group, and double-click a tank in the list.

On the Display menu, select Open > Tank Detail. The Select Tank Point window appears.
Select a Tank, and then click select.

The tank detail opens and is shown below.

Varec, Inc. 25



Managing Individual Tanks

# FuelsManager - Operate
Display View Alarm Point Movements Took Detal Help

@23“\; 1)

AP 1 " NPy LS T X 2K 7)) |

i Static Tank Groups  #

/5 West Tank Group” ] \\ WESTTNKFRM \TankFar... |

W) Tanks
 saer
Tank _ Static Tank Groups i Name ;
Information 53 West Tank Group
Messured Values Tank Status
Level st | 25:00-00  [EEEH Tank Command Mode ~_ set |
10/6/2006 4:39:39FM
Temperature : =) - Transfer Mode s« | Enauwe
ki 9Py -
i i Current Tank Status Stopped
Set Button Water Lovel | 0-00-00 Hindioin
a i Current Transfer Status

10/6/2006 4:13:48 PM
Density =
10/6/2006 4:39:57 PM

Standard Density =
10/6/2006 4:13:48 PM

| “AFI
] “API

Calculated Values

Transfer Shutdown

Advisory Setpoint

Transferred Volume

Time Remaining

Flow Rate

0.00
s | 15.00 [

0.00

sl US)

0.00

em (US)

Total Observed Volume - TOV

Tank Parameters

&) s8.0000]

Water Volume - FW gl (US)

1.00000

Tank Shell Correction (CTSh) High | s=t 34-00-00
Volume Correction Factor (VCF) 1.00000 i

Correction Method
Net Standard Volume - NSV 6,250.00 |REIO

Available Product

21
6,250.00

Mass

4 Dynamic Tank Groups
%] Historical Trends

9 Historical Reports

] Realtime Trends

|| Dynamic Reports

Q/ Q ﬁ @) i?\z No UnAcknowledged Alarms

Larence

Ready 10/9/2006 3:58:38 Pl

Data Field Alarm Settings Tank Image

Manually Overriding Tank Data

As an operator, you can manually set a tank parameter to equal a value of your choosing instead
of the data received from the field. This affects the value of any calculated data derived from the
value you set.

Note The Operator Command window shows you current, minimum and maximum values.

Overriding Tank Data

1. Click the appropriate SET button to enter a new value. The Operator Command window
appears. This example window lists the attributes of the variable, such as database system,
the database point and tank description.

3]

Operator, Command

System  WFME
Database Poirt
TarkFarm Tark 13 Tark
Descrigtion Tark 13
Variable  Level

Current Value
20300

New Value

[a I

Minimum Maimum
0-00-00 40-00-00

Ereeite

2. Change current values by typing the required value in the text box or by sliding the scroll
bar.
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3. Click the Manual Override check box. This overrides the current value in the system.

4. Click the Execute button to change the value. The new value is transmitted to the Fuels-
Manager System.

Identifying Manual Overrides

FuelsManager identifies overridden values with the superscript FRC anywhere the database value
appears. Other values may be affected by these forced values. These values also contain
superscripts indicating the consequence of the forced value. Several example values containing
superscripts are shown in the following table.

Superscript values Description

FRC Input data has been forced to the current value.

OVR Input data exceeds maximum value (over range).

UND Input data falls below minimum value (under
range).

CAL Calibrated data has been derived.

Note The SET buttons involved in performing a tank transfer are different from the SET
buttons mentioned in this discussion. Please see the operations section entitled ‘Tank
Transfers’.

Performing Tank Calculations

The Calculator command from the window menu allows you to perform calculations manually
for tank data. This option is useful for performing ‘what if’ type calculations, allowing you to see
what the level would be if 5000 gallons of product was added to the tank or what volume would
be at the high level alarm limit. The results of the calculations are only shown within the
Calculator window and not transferred to the Tank Detail.

Note In order to perform calculations, a Tank Detail window must be displayed and cur-
rently active.

Opening the Calculator

1. Select Window from the Menu bar. A pop-up menu appears.

2. Choose Calculations. The Calculator window appears.

Performing a Calculation

Note Changing values in the Calculator does not affect the existing data found in the Tank
Detail window.

Some values within the calculator cannot be changed. These values appear gray.

1. Select Window from the Menu bar. A pop-up menu appears.

2. Choose Calculations. The Calculator window appears.
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Calculator == WFMENTankFarm. Tank 16. Tank

Dt fiem [ Start Values | End Values | Differertial Values |

Lewel (ft-in-16th) 108 108 0-00-00

Water Level (ftn-16t) 000-00 000-00 0.00-00

Solids Level (ft-in-16th) 00000 00000 0.00-00

Tempersiure ("F) 800 800 o

Ambert Temp (°F) 00 00 o

Vapor Temp. (°F) -3000 -3000 00

Vapor Press P3 (PS) 000 0.00 0.00

HBSW o 0 [

Standard Densty (“4P) 0.00 0.00 000

Densty (*4P1)

Tark Shel Carr Fac

Volume (gal (US)) 956750.00 958750.00 om

Reof Correction (gal (US))

Hydroleter Value

Volue Gross (gal (US)) 95575000 955750.00 0.00

Vol Avaiable Gross (gal (US))

Vol. Remining Gross (el (US))

Total Net Wolume (gal (LIS))

Walume Net (gal (LS]) 958750 00 958750 00 0

Vapor Net volume (el (US))

volume Avaisble Nt (gal (US)

Yolume Remaining Net (gl (US)

Batiom Volume (gal (US))

Water Volume (gal (US)) 0m 000 oo

Solids Volume (gal (US)) 00 000 oo

Mass (Ib)

Liguid Mass () 3601243.75 3601243.75 0.00

Vapor iass (b)

Mass Svalable (15)

Mass Remaining ()

Volume Carrection (gal (US)) 0.00 0.00 om

Vapor Densty (bit?) 0.00 0.00 om

Density Temperature (°F) 0.00 0.00 om
Print

&)

Click on the parameter to be changed. An Operator Command window will be displayed.

Select or type in the new value.

Click Execute. The changes appear in the Calculator window.

Note Operators are able to print out the results of any calculations from the Calculator

window.

Changing one parameter value causes all data derived from the parameter to be recalculated,

i.e. changing the level parameter will cause all volumes to be recalculated.

Monitoring Tank Transfers

You can use FuelsManager to monitor the transfer of product into or out of a tank. This is done
by defining setpoints; FuelsManager then enables alarms when the setpoints are reached.

1.

The database calculates the volume of product transferred and time remaining to transfer

completion.

An alarm occurs when the advisory setpoint is reached.

An alarm occurs when the shutdown setpoint is reached, indicating the end of the transfer.

Note A tank transfer can only be performed from the Tank Detail window.
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Turning on Tank Transfer Monitoring

To monitor a transfer:

Note Clicking execute affects the displayed units found in the Advisory and Transfer SD
(Shutdown) Setpoint.

1. Click on the Transfer Mode Set button. An Operator Command window appears.

Operator Command g\
Commands

System: FWE

Databass Point

TankFarm Tankc 16 Tank Xfr Level

Description  Tank 18

Variable  Transfer Mode

Inactive

¥ir Yolume

i Diff vl

Current Value  Inactive

2. Select the mode for the Tank Transfer. See the table below for a description of each mode.

Xir Mass

Xir Diff Mass

Transfer Mode Description

Command

Inactive Terminates tank transfer monitoring

Xfr Level A transfer that is terminated by defined Level.

Xfr Volume A transfer that is terminated by Stop Total Volume.

Xfr Diff Vol A transfer that is terminated by the Stop Differential
Volume (change in volume).

Xfr Mass A transfer that is terminated by the Stop Mass.

Xfr Diff Mass A transfer that is terminated by the Stop Differential

Mass (change in mass).

Click Execute.

Click on the Transfer Shutdown Set button. An Operator Command window appears.
Select or type in the new tank value.

Click Execute.

Click on the Advisory Setpoint Set button. The Operator Command window appears.

© N o v kW

Select or type in the time. This time is used to set when the Advisory Alarm occurs. Click
Execute.

9. Click Tank Command Mode Set button. An Operator Command window appears.

10. Select the appropriate command and then click Execute. This action begins the transfer
monitoring process.

Turning Off Tank Transfer Monitoring

1. Click the Transfer Mode button. An Operator Command window appears.

2. Select Inactive and click Execute.

Tank Detail Field Descriptions

The following table contains the tank field descriptions.
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Field

Description

Tank

Displays the name of the tank.

Description

Displays the description of the tank.

Product

Displays the product and product description contained
in the tank.

Level

Displays the current level of the tank.

Level Time

Displays the last time that the tank level was updated.

Temperature

Displays the current temperature of the tank.

Gross Volume

Total measured volume of the product, corrected for
Water Level, % BSW, and Roof Volume. This is calculated
from the tank gauge reading and the tank-strapping
table.

Net Standard Volume

The corrected volume of the product in the tank. This is
calculated by multiplying the Gross Volume by the
Volume Correction Factor.

Net Available Product.

Net Volume of product that can safely be issued from the
tank. This is calculated by subtracting the Net Standard
Volume at the minimum working level from the current
Net Standard Volume.

Net Remaining Capacity

Net Volume of product that can be added to the tank.
This is calculated by subtracting the current Net Standard
Volume from the Net Standard Volume at the maximum
working level.

Density

Displays the current observed density of the product at
the current temperature.

Density Time

The last time that the Density value was updated.

Standard Density

Displays the density of the product corrected to the
standard temperature as defined by the selected
correction method.

Mass

Displays the product mass based on density.

Water Level

Displays the level of water (if any) in the tank.

Water Volume

The volume calculated from the strapping table at the
water level.

Flow Rate

The rate of movement based on consecutive level
readings. Calculated from the change in volume and the
time interval between scans of the tank level.

Tank Command Mode

The desired mode of the tank operation: stop, fill, empty,
run, test, reset, or out of service.

Tank Status

The actual direction of product flow into or out of a tank.
The current state of the tank mode: stopped, filling,
emptying, running, testing, or disabled.

Transfer Mode

How the transfer is measured: inactive, level, mass,
volume or by differential volume or mass.

Transfer Status

The current status of a transfer; displays In Progress,
Advisory, or Complete. If there is no active transfer for
the tank, the status is Inactive.

Transfer Shutdown Setpoint

The limit that defines the end of a tank transfer. The
units for this value are determined by the Transfer Mode
setting.

Advisory Setpoint

The time remaining before a reminder (advisory) alarm
appears. Typically, this is set to provide warning that the
tank transfer is about to be completed.
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Field Description

Transferred Volume The amount of volume transferred into or out of a tank
during the tank transfer, or the amount transferred thus
far if a transfer is active.

Time Remaining The time left to complete an active transfer, based on the
amount left to transfer, and the current flow rate.

HiHi Alarm The limit for a high-high level alarm. If the tank level
exceeds the HiHi Alarm, then an alarm ensues.

Hi Alarm The limit for a high level alarm. If the tank level exceeds
the Hi Alarm, then an alarm ensues.

Lo Alarm The limit for a low level alarm. If the tank level drops
below the Lo Alarm, then an alarm ensues.

LoLo Alarm The limit for a low-low level alarm. If the tank level drops
below the LoLo Alarm, then an alarm ensues.

Tank Mode Commands

The following table contains the tank mode commands.

Tank Mode Command Description

Stop Stops tank - No movement allowed

Fill Fills tank - Upward movement only

Empty Empties tank - Downward movement only

Run Tank could be Filling/Emptying/Stopped. Mode alarms
are disabled

Test Mode and Operational alarm disabled. Level alarms not
affected

Reset Resets an illegal Movement Alarm Current. Level/Volume

are recaptured and movement monitoring begins again
based on the new data

Out of Service Tank is disabled. All alarms are disabled.
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5 Managing Multiple Tanks

FuelsManager Oil & Gas fuel farm management software provides tools for working with an
entire tank farm, or with individual tanks. This chapter describes how you can manage multiple
tanks with FuelsManager.

Understanding Tank Groups

Tank Groups are sets of two or more tanks with common characteristics. FuelsManager provides
two types of tank groups and two methods for displaying each group.

Tank Group Types: Static or Dynamic

Static Tank Groups

A Static Tank Group is composed of tanks that have been explicitly identified as part of the
group. Generally, Static Tank Groups are based on tank location. For example, if tanks 16-20
are located in the West tank farm, then West Tank Group = tank 16, 17, 18, 19, and 20.

Dynamic Tank Groups

Dynamic Tank Groups are groups of tanks that have common characteristics. You define the
requirements for the group, and then FuelsManager identifies all of the tanks with the required
characteristics and includes them in the group.

For example, Dynamic Tank Group 1 = all tanks with temperature above 40°.

Tank Group Display Formats: Graphical or Tabular

FuelsManager displays all the tanks in a group in a single window. You can view tanks in a group
as graphical images or as rows in a table, and you can quickly switch between display types.

Both display methods allow you to open the Tank Detail for any tank in the group, view the
process data for each tank, and change the value of tank data from the group window.

FuelsManager uses a default tank group template to define the initial tabular display of each new
group. You can modify this template. For more information, see “Modifying the Default Tank
Group Template” on page 48.

Opening a Tank Group

To open a Tank Group Using a Task Group
1. Open the Static Tank Groups or Dynamic Tank Groups task group.

2. Double-click on the tank group that you want to view.

To open a Tank Group Using Tank Group Select

1. Do one of the following to open the Tank Group Select window:Press ‘F8’ key on the key-
board.

On the Display menu, select Open | Tank Group.
Click on the Tank Group button on the toolTank Group Select window

Varec, Inc.
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1. Click the box with the ‘+’ sign to the left of Static or Dynamic. The tree structure expands
to show the predefined Tank Groups.

Tank Group Select §|

+ - Static
+|- Dynamic Template

o

[ ]

Note When a Tank Group is selected, it appears in the same format (Tabular or Graphical)
as the last viewed Tank Group.

2. Select a tank group by doing one of the following:

Click on a Tank Group and then click the Select button
Double-click on a Tank Group
The selected Tank Group window appears.

Viewing a Tank Group

You can view any tank group as a set of images or as rows of data in a table. This section
describes how to switch between these display formats, and how to use each format to manage
your site’s tanks.

Selecting the Tank Group Display Format

To switch between a graphical or tabular display for an active Tank Group, do one of the
following:

Press the F9 key on the keyboard.

On the Edit menu, select Toggle View.

Viewing a Tank Group as a Graphical Display

In a graphical tank group display, each tank is represented by a realistic, three-dimensional
graphic showing the tank size and shape. The graphic includes a bar graph showing the current
product level, a tank status icon, flow icons, a single process variable, and level alarm setpoints,
as shown below.
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Status Icon
Bar Graph

Process
Variable

Transfer
Indicators

Alarm
Setpoints
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This section describes how you can use a graphical tank group display to quickly identify the
status of tanks in the group, and how you can access Tank Details for any tank in the group.

Opening the Tank Detail from the Tank Group Display

Double-click on the appropriate tank image. The Tank Detail appears for the selected tank.

Checking the Tank Status

Tank Status Icons are pictures that represent the state of each tank in a Graphical Tank Group

Display. The meaning of each icon is explained below.

Test Mode
Scan Failure

Out of Service i =

Reverse Flow

Run

Alarm

o o

Displaying a Process Variable

Movement

Filling

Emptying

No Flow @

Flow Failure

You can set FuelsManager to display a process variable with each tank graphic. Options include
the current product level, current water level, tank status, and product flow.

1.  On the Operate window menu bar, select the Edit menu, and then click Select Alt View Pro-
cess Variable.

2. Select the process variable that you want to display for each tank in the Tank Group display.
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Click OK. The process variable that you selected is displayed in each tank graphic. For an

example, see the graphic on the previous page.

Move the mouse over the bar graph.

A box appears showing the current level as a percentage value.

Checking the Current Product Level in a Tank

Checking the Alarm Indication Levels for a Tank

Move the mouse over the letters indicating an alarm level, e.g. High Level alarm (H).

A box appears showing the percentage value of contents in the tank at which a High Level

alarm will occur.

Right-click the tank graphic and select Process Data.

The tank window opens and displays the tank variables, as shown below.

Issuing Tank Commands from the Graphical Interface

Active Tanks RTULTankl

Warishle

Product Code

Level (ft-in-16th)
Temperature (*F)
“olume Gross (gal (US)

Tank Status

Yolume Available Met (gal (US))

Walue

“Mo Product=
14-05-12"4
36".‘!"

3620

2120
Stopped"et

|

m

s
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3.

4.

Scroll down to Tank Command, as shown below:

Active Tanks.RTUL Tankl =

Warishle Yalue g
Yolume Available Met (gal (US)) 2120

Tank Status Stopped"et LK
Flowe {gpm (US)) [Fre

Trans Complete Time E
Trans S0 Setpoint 0

rrand

Operator Command IEI
Commancds
WAATEST-O0
Ayctive Tanks RTU Tank1 Stop
Active Tanks Fill
Tank Command
Current Value  Stop Empty
Run
Test

Reset |
Cut of Service |

5.
6.
7.

Double-click Tank Command to open the Operator Command window, as shown below.

Click any of the commands in the Command list. The Execute button becomes active.

Click Execute in the Operator Command window.

Click OK in the Active Tank window.
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Viewing a Tank Group as a Table

As an alternative to Graphical Tank Group Displays, you can view tank groups as rows of tank
data in a table. The key items in a Tabular Tank Group Display are shown in below.

Tank Group List

Column Heading

Database Point
(Tank Name)

Real-Time

Data

Column Totals —

# FuelsManager - Operate
Display View Alarm Point Movements |Tools Edit Help
1= =sR" SR RN R SN ] R B 0 5 ol g/&@ﬁ;
i '\m"g U T o e D 33.@"0/ 2 s 8= o
{ Static Tank Groups % {7 West Tank Group | 4bx
¥ Tanks West Tank Group Product Code ‘ Level | Temperature ‘ Volume Gross Volume Available Net Tank Status | Flo
#" Graphics
- Static Tank Groups Tank 1 CRUDE 20-00-00 60 5,000 3,500 Stopped
st Tank Group
57 West Tank Group Tank 2 GAS 30-00-00 60 7.500 6.000 Stopped
Tank 3 GAS 25-00-00 60 6,250 4750 Stopped
Tank 4 GAS 33-00-00 60 8250 6.750 Stopped
Tank 5 GAS 12-00-00 60 3.000 1.500 Stopped
Tank 6 GAS 18-00-00 60 4,500 3,000 Stopped
Tank 7 GAS 31-00-00 60 7.750 6.250 Stopped
Tank 8 GAS 15-00-00 60 3750 2,250 Stopped
Tank 9 GAS 24-00-00 60 6,000 4,500 Stopped
Tank 10 GAS 24-00-00 60 6,000 4,500 Stopped
Tank 11 GAS 24-00-00 60 6.000 4.500 Stopped
Tank 12 GAS 32-00-00 60 8,000 6.500 Stopped
Tank 13 G 8-00-00 60 2,000 500 Stopped
Tank 14 HOIL 25-00-00 60 6.250 4,750 Stopped
Tank 15 HOIL 25-00-00 60 6.250 4.750 Stopped
Tank 16 HOIL 5-00-00 B0 1,250 0 Stopped
Tank 17 HOIL 25-00-00 60 6,250 4,750 Stopped
Tank 18 HOIL 12-00-00 60 3.000 1.500 Stopped
Tank 19 HOIL 25-00-00 60 6,250 4750 Stopped
Tank 20 HOIL 28-00-00 60 7,000 5,500 Stopped
4 Dynamic Tank Groups
] Historical Trends Total:
%] Historical Reports
| Realtime Trends
| Dynamic Reports < 2]
@ Q \g @, m No UnAcknowledged Alarms
Tank Calculator Lawrence 10/9/2006_4:08:10 PM NUM

This section describes how you can use a tabular Tank Group display to quickly identify the
status of tanks in a tank group, and how you can access Tank Details for any tank in the group.

Viewing

Tank Data

Each Tank Group cell displays the current data of the particular tank variable (as indicated by
the column heading). Changing the column variable will change the data within that column, you
can also modify individual cells manually.

Opening the Tank Detail from a Tabular Tank Group Display

- Double-click the row heading (database point cell) for the appropriate tank. The Tank Detail
appears for the selected tank.
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Adding a Tank Group

This section describes how to add a new static or dynamic tank group.

Adding a New Static Tank Group

Creating a static tank group consists of the following steps. This first step is described in this
section.

Add a new static tank group and give it a name.
Add tanks to the tank group.
Set up the tabular and graphical displays for the tank group.

To add a tank group
1. Do one of the following to open the Tank Group Select window:

Press ‘F8’ key on the keyboard.

Tank Group Select E|

+- Static
+- Dynamic Template

LR

[

On the Display menu, select Open | Tank Group.
Click on the Tank Group button on the toolbar.

Right-click in a Static Tank View task group or a Dynamic Tank View task group, and
then click Add.

2. In the group type list, click Static, and then click the New button.

3. In the New Tank Group Name window, enter the name for the new tank group.

4. Click the OK button. The new tabular tank group display appears.

The tabular display is empty; this group does not contain any tanks. Proceed to set up the group
as described in the following sections:

“Adding or Removing Tanks In a Static Tank Group” on page 40.

“Changing Tank Group Graphical Display Settings” on page 44.

“Changing Tank Group Tabular Display Settings” on page 45
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Adding a Dynamic Tank Group

Creating a dynamic tank group consists of the following steps. The first step is described in this
section.
Add a new dynamic tank group and give it a name.

Define the filter or filters that FuelsManager will use to determine which tanks appear in the
group.

Set up the tabular and graphical displays for the tank group: determine which process
variables to display, etc.

To add a dynamic tank group
1. Do one of the following to open the Tank Group Select window:

Press ‘F8’ key on the keyboard.

Tank Group Select E|

+- Static
+- Dynamic Template

LR

[

On the Display menu, select Open | Tank Group.
Click on the Tank Group button on the toolbar.

Right-click in a Static Tank View task group or a Dynamic Tank View task group, and
then click Add.

2. In the tree view, click Dynamic, and then click the New button.
3. In the New Tank Group Name window, enter the name.

4. Click the OK button. The new tank group appears with a tabular display.

The tabular display is empty; this group does not contain any tanks. Proceed to set up the group
as described in the following sections:

“Defining a Filter for a Dynamic Tank Group” on page 42.

“Changing Tank Group Graphical Display Settings” on page 44.

“Changing Tank Group Tabular Display Settings” on page 45.

Adding or Removing Tanks In a Static Tank Group

This section describes how you can set up a contents of a Graphical Tank Group window using
the Edit and the Tank Group menus:

The Edit menu is available from the Menu bar at the top of the screen and provides a
number of options. Some menu items are unavailable when the Graphical Tank Group
display is active.
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The Tank Group menu is available by right-clicking on a tank from the Graphical Tank
Group window. An example appears below.

Modify [ add Tank
Insert Tank
Delete Tank

Clear Tank

Tank, Detail

Process Data

Note You can place up to 105 tanks on a single Static Tank Group at one time. However,
an unlimited amount of tanks may be added for a Dynamic Tank Group.

Note Any changes made to the Graphical Tank Group window is also made to the Tabular
Tank Group window.

Adding a Tank to a Tank Group
Use this procedure to add a tank to a tank group.

1. Right-click on a tank graphic or tank name cell to open the Tank Group menu.

Note The new tank will be inserted into the position just before the tank you right-click
on.

2. Click Insert Tank. The Select Tank Point window opens.

3. Select a tank. The tank you selected is inserted into the group.

Replacing a Tank in a Tank Group
Use this procedure to remove a tank from a tank group and insert another tank in its place.

1. Right-click on a tank graphic or tank name cell to open the Tank Group menu.
2. Click Modify/Add Tank. The Select Tank Point window opens.

3. Select a tank. The tank you selected replaces the original tank.

Removing a Tank from a Tank Group
Use this procedure to remove a tank and its image cell or row from a tank group.

1. Right-click on a tank graphic or tank name cell for the tank that you want to delete from
the group.

2. Click Delete Tank/Row. The tank is removed from the group; subsequent tank images/rows
move up to fill the vacated space.

Clearing a Tank from a Tank Group Display

Use this procedure to remove a tank from a tank group and leave its position empty in the image
grid or table.

1. Right-click on a tank to open the Tank Group menu.

2. Click Clear Tank. The tank is removed from the selected position in the image grid or table.
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Defining a Filter for a Dynamic Tank Group

Each dynamic tank group uses a filter to determine which tanks should be included in the group.
This section describes how to set up a filter for a dynamic tank group.

Before You Begin

Create a dynamic tank group as described in “Adding a Dynamic Tank Group” on page 40.

Creating a New Filter

1.
2.

Open the dynamic tank group.

Right-click the Tank Group Name cell. The Tank Group Name menu appears. (Option 2:
Select the Edit menu from the Menu bar).

Select Filter Setup. The Dynamic Tank Group Setup window appears.

Use the Variable, Condition, Result, and Units fields as appropriate & applicable to define
your filter condition.

See “Creating a Filter: Example” on page 42 for an example of setting up a filter.

To add a filter condition, right-click the Variable field heading, and then select Add, and
define the condition.

Click Close. If there are tanks that meet the filter conditions, they appear in the tank group
display.

Creating a Filter: Example

The following example describes how to set up a dynamic tank group filter to show all tanks
from the current database with a level greater than 30 ft.

1.

Open the dynamic tank group.

2. Right-click on the Tank Group Name cell. The Tank Group Name menu appears. (Option 2:
Select the Edit menu from the Menu bar).
Select Filter Setup. The Dynamic Tank Group Setup window appears.
4. Click in the Variable cell. A drop-down menu appears with a list of variables to choose from.
Variable | condition | Result [ Units | pea
b
cance

5. Select Level. Level is now the selected variable.

6. Click in the Units cell. A drop-down menu appears with a list of units to choose from.
Select ft./inch/16th. ft./inch/16th is now the selected unit. The format of the Result and
Deadband cells changes to the format of the selected units.

8. Click in the Condition cell. A drop-down menu appears with a list of symbols to choose

from.
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10.
11.

Select the Greater Than (>) symbol. Greater Than is now the selected condition.
Change the value in the Result cell (00-00-00) to read 30 feet (30-00-00).

Click OK. The Tank Group window now contains all tanks from the database with a level
greater than 30 feet.

Note During normal operations, if a tank’s level rises above or falls below 30 feet, that
tank will be added or removed from this Dynamic Tank Group display.

Refining a Dynamic Tank Group Selection

A Deadband value can be used when configuring the Filter Setup for any Dynamic Tank Group.
Continuing from the example above, you may only wish to see tanks within 5 feet 6 inches of
the 30 feet value.

1.

In the Dynamic Tank Group tabular display, right-click on the Tank Group Name cell. The
Tank Group Name menu appears.

Select Filter Setup. The Dynamic Tank Group Setup window appears with the current values
for the Dynamic Tank Group still in place.

Scroll to see the Deadband column cell and modify this value (00-00-00) to read 5 feet 6
inches (5-06-00). The Tank Group window dynamically changes to contains all tanks from
the database with a level from 24 ft. 6 Inches to 35 ft. 6 inches.

Dynamic Tank Group Setup Window Fields

Field Description

Filter Setup Menu If user rights clicks within the Dynamic Tank Group Setup

window, the Filter Setup menu will display with Add, Insert
and Delete capabilities.

Conditional Expression This is where you will open a bracketed expression.
Variable Tank Variables that can be set up for filtering.
Condition The conditions that can be set up for filtering:

> Greater Than

Less Than

= Equal To

>= Greater Than or Equal To

<= Less Than or Equal To

<> Not Equal To

Result The result available for filtering will be based on the variable

selected in the Variable field. For absolute values, there will
not be a drop-down list. However, there will be an edit field.

Close Conditional This is where you will close a bracketed expression. Available
Expression options are: ‘)’ or *“
Unit Allows user to select the units for the number entered or a

percent. This field is only available for numbered variables.
This field will be populated with the available units for the

variables selected and will be disabled for variables that do
not have units.

Deadband The deadband of the result in the selected unit result.
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Changing Tank Group Graphical Display Settings

This section describes how to tank group display settings.

Displaying a Process Variable

A single Process Variable can be displayed below the tank. This variable is the same for each
tank in the display.

To display a process variable
1. Select Edit menu from the Menu bar.

2. Select ‘Select Alt View Process Variable’. The Select Process Variable window appears.

Select Process Yariable

|Level ﬂ

Cancel |

3. From the drop-down menu, select the desired variable to display.

4. Click Select. The Process Variable is shown at the bottom of each tank in the display.

Selecting a Background Color Scheme
FuelsManager Operate allows you to choose from the following background color schemes:

Green grass with sky
Sand with sky
Earth with sky

To select a background scheme
1. Click Edit > ‘Select background Scheme’. The Select Tank Background window appears.

2. Check the box below the desired background.

3. Click OK. The background scheme for all tanks changes to the selection.

Showing Tank Information

Using the Edit menu, FuelsManager Operate allows you to display the following tank information
graphically as icons on the tank image:

Flow

Tank Status

Water Level

Point Description

To hide the Display Flow Icon
Select Edit menu from the Menu bar.
Move the mouse to highlight Display Flow and click.
The icon on each tank image is removed.

44 User Manual



FuelsManager Oil & Gas

If the Edit menu is selected again, the check mark to the left of Display Flow has also been
removed, indicating this value or icon is not displayed.

Note In the Edit menu a check is displayed next to each of these commands to indicate
that the value/icon is displayed on the Tank Group.

Changing Tank Group Tabular Display Settings

You can use the instructions in this section to change the tabular display for a static or dynamic
tank group.

Tank Group Name

This field displays the unique name that you have assigned to the Tank Group. The Tank Group
name can be any combination of numbers, upper or lowercase characters, spaces, or other
punctuation marks, up to a maximum length of 30 characters. (The Tank Group name cannot
include any of the following characters: forward slash (/), backslash (\), comma (,)).

Note The Column Header Alias window also has a reset button that sets the column head-
ing text back to the default FuelsManager Variable text.

Setting the Number of Database Levels to Display

You can select the number of FuelsManager database levels to be displayed in the left hand
column of the Tank Group. Such as, a typical FuelsManager database tag name looks like:

Areal.Tank123.TankPoint

Where:

TankPoint is database Level O

Tank123 is database Level 1

Areal is database Level 2

Database Level 3 does not exist in this example.

Right-click the Tank Group name cell. The Tank Group Name menu appears.
Select Set database Levels. The Database Level Display Configuration window appears.

Selecting the check boxes allows you to set which level, or combination of levels to be dis-
played in the left hand column of the Tank Group window.

Click OK. The format of the database levels changes according to the selection.

Configuring Columns on a Tabular Display
All column headings are user-configurable. Using the Column Heading menu, you can modify,

add, insert or delete columns, as well as display column format, change units and select column
title aliases. Depending on the contents of the column some commands may not be available.

Modifying the Column Header Alias

You can change the text displayed for the selected Tank Group column heading. Changing the
Column Header Alias only affects the displayed group and does not change the template.

Right-click on the column heading to be modified. The Column Heading menu appeatrs.
Select Header Alias. The Column Header Alias window appears.

In the text box, type the new Tank Group column heading.

Varec, Inc.
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4. Click OK.

Modifying the Column Format

Note Changing the format of a column only affects the displayed group and does not
change the template.

From Set Column Format window, you can:

Use the Precision text box to set the number of digits to the right of the decimal point in the
column.

Use the Field text box to set the number of digits to the left of the decimal point in the
column.

Note If the data to be displayed is bigger than the size entered in the Field and Precision
fields, the data will be displayed as ###### in the Tank Group window

To set the column format
1. Right-click on the column heading to be modified. The Column Heading menu appears.

2. Select Display Format. The Column Header Alias window appears.
3. In the text box fields enter the required values.

4. Click OK. The changes are applied to the column.

Selecting and Displaying Engineering Units

The Select Engineering Units window, which is available from the Column Heading menu allows
you to set the engineering units to be used for the selected Tank Group column. You are
provided with a number of options from this window, such as:

A list box displaying the available engineering units applicable to the column selected.(i.e.
Temperature, Level, Volume, etc.). FuelsManager automatically selects the appropriate unit
type based on the tank variable column selected.

The Clear button resets the engineering units for the selected column to the default
engineering units configured for the tank.

Deleting a Column from a Tank Group
1. Right-click on the column heading to be modified. The Column Heading menu appears.

2. Select Delete Column command. The column selected is deleted from the view.

Changing the Font Size in the Tabular Tank Group

The font size for all elements of the Tank Group display can be increased or decreased.

Note The font size in a Tank Group window has a maximum and minimum value. Chang-
ing the font size beyond these values will have no effect.
1. Right-click on any cell in the Tank Group. The Real-Time Data menu appears.

2. Select Increase Font Size (or Decrease Font Size). The font is changed according to the
selection.

Setting the Total and SubTotal Rows

The FuelsManager configurable Tank Group supports the selective totals of columns via a Total
row placed at the bottom of the display or at a fixed position. Fixing the position of the Total
row allows it to remain visible when you scroll past the allowable 20 tanks per page. In addition,
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Static Tank groups support SubTotal rows that can be used to provide sub-totalization of user
defined tanks.

Calculating a Column Total and SubTotal
To calculate a total or subtotal sum for a particular column, perform the following operation:

1. Right-click on the column heading to be modified. The Column Heading menu appears.

2. Select Column Total. The sum of values is shown in the Total and/or SubTotal rows.

Selecting the Location of the Total Row

The location of the Total row can be moved so that you can always see on screen the total values
or it can be placed at the bottom of all rows.

1. Right-click on the Database Point after the Database Point where the Total row is to be
positioned. The Database Point menu appears.

2. Select Set Total Position. The Total row is now inserted into position above the Database
Point selected.

Freezing the Total Row

Note If Freeze Total Row is set, then the SubTotal Position will be disabled from the Data-
base Point menu. If SubTotal Position is set, then Freeze Total Row will be disabled from the
Database Point menu.

To freeze the position of the Total row perform the following operation:

1. After positioning the Total row to a desired location on the Tabular Tank Group grid, right-
click on the Total row. The Database Point menu appears.

2. Select Freeze Total Row. The Total row will remain at the set position when you scroll past
the allowable 20 tanks per page

Selecting the Location of the SubTotal Row

Note Subtotals can only be inserted from a clear tank row.

The location of the SubTotal row can be inserted to allow you to quickly see the sub-totalization
of user defined tanks.

For example, if tanks 1-5 contain gasoline and tanks 6-10 contain crude you could build a static
tank group that included tanks 1-5 followed by a SubTotal row, then tanks 6-10 followed by a
SubTotal row then a space and a final Total row. This tank group would allow you operator to
quickly see the total gasoline, the total crude supply and the overall site product totals on a
single display.

1. Right-click on the clear row following the tank group row(s) where the SubTotal row is to
be positioned. The Database Point menu appears.

2. Select SubTotal Position. The SubTotal row is now inserted into position below the tank
group row(s).

Changing a Tank Variable in a Tank Group Cell

To manually change a tank variable in a Tank Group Tabular Display cell, perform the following
steps.

1. Right-click the real-time field to be modified. The Real-Time Data menu appears.
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Select Set. The Operator Command window appears. This example window lists the attri-
butes of the variable, such as the database point, tank description and value.

Change current values by typing the required value in the text box or by sliding the scroll
bar.

Click the Manual Override check box. This overrides the current value in the system.

Click the Execute button to change the value. The new value is transmitted to the Fuels-
Manager System.

Modifying the Default Tank Group Template

When you create a new static or dynamic tank group, FuelsManager uses a standard tank group
template as a definition for the tabular display of the new group. This template defines the tank
data that initially appear in each group, and determines the format of the group. It does not
define which tanks will appear in the group.

You can modify the default tank group template if the existing template does not meet your
site-specific needs. Each time you create a new tank group, it will reflect the customized
template settings.

Note The default tank group template defines the tabular display of new tank groups. You
cannot alter the default settings for graphical tank group displays.

Do one of the following to open the Tank Group Select window:

Press ‘F8’ key on the keyboard.

Tank Group Select EJ

+|- Shatic:
+- Dynamic Template

il

[

On the Display menu, select Open | Tank Group.
Click on the Tank Group button on the toolbar.

Right-click in a Static Tank View task group or a Dynamic Tank View task group, and
then click Add.

Click the Template button. The default tank group template appears in a tabular display.To
add tanks and define other group properties, “Changing Tank Group Graphical Display Set-
tings” on page 44.

Modify the template as appropriate. Options include:

Add, remove, or change columns (tank data fields), as described in see section .

Set the number of database levels to be displayed for each tank name in row heading
cells, as described in see section .

Close the view display for the template. The changes you made are saved in the template.
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Command Summary

Command

Description

Display ‘ Open

‘ Tank Group (F8)

Allows you to select a Tank Group to open.

Edit Menu

Only available when the Tank Group window is active.

Edit

Modify Column

Allows you to change the currently displayed variable in the
selected column.

Add Column

Allows you to add a column to the right of all existing columns
in a Tabular Tank Group.

Insert Column

Allows you to insert a column to the left of the currently
selected column in a Tabular Tank Group.

Delete Column

Deletes the selected column in a Tabular Tank Group.

Modify/Add Tank

Allows you to change the currently selected tank in a Tabular
Tank Group.

Insert Tank

Allows you to insert a Tank above the currently selected row in
a Tabular Tank Group.

Delete Tank/Row

Deletes a tank, moving all tanks up one row to fill the space.

Clear Tank

Clears a tank leaving all tanks in the original positions,
creating a blank row/position.

Display Format

Allows you to change the numeric format for data in the
selected columns.

Select Units

Allows you to select the required engineering units for the
selected column. All values will be converted to the selected
engineering units.

Increase Font Size

Increases the font size throughout the Tank Group.

Decrease Font Size

Decreases the font size throughout the Tank Group.

Header Alias Allows you to customize or reset the currently selected column
heading in a Tabular Tank Group.
Filter Setup Allows you to define the criteria for a Dynamic Tank Group.

Select Alt View Process Variable

Allows you to view additional process data from the Graphical
Tank Group.

Select Background Scheme

Allows you to select the background color scheme for a
Graphical Tank Group.

Display Flow

Toggles the display of the flow icon on a tank group image for
a Graphical Tank Group.

Display Tank Status

Toggles the display of the tank status icon if appropriate for a
Graphical Tank Group.

Display Water Level

Toggles the display of the water level in the tank bar graph for
a Graphical Tank Group.

Display Point Description

Allows you to display the Tank Point description for a
Graphical Tank Group.

Toggle View (F9)

Toggles between the Graphical and Tabular Tank Group views.

From Tank Group Menu

Tank Detail opens the selected Tank Detail window.

Process Data

Displays the Process Data for the selected tank.

Set

Allows you to view or change the currently selected variable.

Column Total

Calculates a total value for the selected column and displays
this in the Total row.
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Command

Description

Sort Ascending

Arranges columns in a Tabular Tank Group into ascending
order.

Sort Descending

Arranges columns in a Tabular Tank Group into descending
order.

Set Total Position

Positions the Total row above the selected column.

Set Total At Bottom

Positions the Total row at the bottom of the Tank Group.

Freeze Total Row

Freezes the Total row in its current position.

SubTotal Position

Changes the currently selected row (selected row must be
cleared first) to a subtotal row.

Set Database Levels

Allows you to select how much of the database tag-name to be
displayed in the left most column in a Tabular Tank Group.
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Understanding Custom Graphics

Note This feature is available with the Professional Edition only.

The FuelsManager system you are using may be equipped with custom graphic displays. Custom
graphics are screens designed for a particular site; these graphics may have built in buttons,
animations or hotlinks that allow you to:

View visual representations of your physical site
Maneuver between windows

Open multiple graphics

Set values

Open reports

Open custom help files

Note The availability of menu items will change according to the type of window displayed.
The Display, Alarm, Point and Tools, as described in the proceeding sections, remain con-
stant for each window type.

Typical custom graphics include Site Overviews and Process Diagrams.

Site Overviews are custom graphics that display a facilities tanks as they are configured on
the site. Clicking a tank in the graphic causes the Tank Detail window to open. See the
figure below for an example.

Process Diagrams are custom graphics that show piping and instrumentation status with
hotlinks allowing you to change the status directly from the custom graphic. For example,
when the mouse is moved over an item, such as a valve, a hand will appear indicating that
you may click and link to a window or custom graphic. In this example, you may then be
allowed to open or close the valve using a command from the window.

Varec, Inc.
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Opening a Custom Graphic Display

Note When FuelsManager Operate opens, a custom graphic displays. This graphic is
referred to as the Index Graphic and is specific to each facility.

To select a keyboard shortcut

1. Do one of the following:
Press the ‘F2’ key on the keyboard. The Graphic Display Selection window opens. Select
a display, and then click the OK button.

On the Display menu, select Open | Graphics. The Graphic Display Selection window
opens. Select a display, and then click the OK button.

On the Toolbar, click the Graphics button. The Graphic Display Selection window
opens. Select a display, and then click the OK button.

Open the Graphics task group, and double-click on a display in the list.
The graphic window opens.

Command Summary

Command Description

Display | Open | Graphic (F2) Allows you to select a graphic to open
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In FuelsManager, reports provide formatted information about your site. Predefined reports are
provided with FuelsManager; your site may also have custom reports that show information
specific to your facility.

As an operator, you can:

Display a report
Print a report
Enable or disable a report

Note When a report is displayed on screen the menu bar contains two additional menus,
Print and Page.

Types of Reports

FuelsManager provides two primary types of reports: dynamic reports, which show real-time
data, and historical reports, which provide the latest archived information or details of inventory
changes over time.

Other FuelsManager reports include:

Log File Browser Reports

Note Please refer to the section ‘Working with Alarms’ for details on Automatic Alarm/
Event and Log File Browser reports.

For complete instructions on configuring historical reports, refer to the FuelsManager
Administrator Manual. There may be a number of historical reports predefined in the system,
including:

Current Tank Inventory

Active Tank

Inactive Tank

Last Full Day Tank Change

7-Day Tank Change

Last Full Week Tank Change

Last Full Month Tank Change

Month to Date Tank Change

Displaying a Report

Using Report Select to Display a Report

1. Do one of the following to open the Report Select window:

Press the ‘F3’ key on the keyboard.
On the Display menu, select Open | Report.
On the toolbar, select the Report
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Report Select

X

Printer:

Repart Marme Description Status

activetank Active Tanks Inactive
currinventary Current Inventory Inactive
inactivetank Inactive Tanks Inactive
operatingtank COperating Tanks Inactive

| | | | Cancel |

2. Select the desired report in the Report Manager window. The report will now be highlighted.
3. Click Display. The selected report is displayed.

Using a Report Task Group to Display a Report

1. Open a Dynamic Reports or the Historical Reports task group.

2. Double-click on one of the reports in the task group.

Viewing Multiple-Page Reports

You can view multiple-page reports using the commands from the Page menu, keyboard
shortcuts or the window scroll bars.

If you are viewing a multi-page Historical Report, as shown below, you can also use the report

toolbar to page through the report, scale the report, refresh the report, and even search for text
in the report.
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Enabling and Disabling a Dynamic Report

You can disable or enable a selected report from the Report Manager window.

- Enabling a report makes the report Active.

- Active reports are printed at preset intervals and print times defined when the report was
created.

- Disabling a report makes the report Inactive.
- Inactive reports do not print at specified times.

« Contact an Administrator or Supervisor for a list of scheduled report print times and
intervals.

- Printing the report does not affect its pre-defined print time or interval. For example,
suppose the Current Tank Inventory Report is set to print every hour (03:00, 04:00).
Printing the report at 03:50 does not affect its scheduled time of 04:00.

- Print Files, which may be viewed using any text file application, should be stored in the
project directory. The designated subdirectories where the files are stored depend on the
facility. Consult an Administrator or Supervisor before continuing.

For example, suppose there are three shifts: morning, swing and night. The Current Tank
Volumes report (which is set to print every 2 hours) is not printed during the night shift. So, the
swing shift operator disables the report before he or she leaves. At the end of the night shift,
the night shift operator enables the report, so that it is printed at the next interval.
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To enable or disable a report:
1. Do one of the following:

In the Dynamic Reports task group, right-click on a report name. A menu appears.
Select the desired report in the Report Select window. The report is now highlighted.

2. Do one of the following:
Click Enable. The selected report becomes active.

Click Disable. The selected report becomes inactive.

You may want to disable a report for several reasons, including printing problems, printer
maintenance, or operator shifts.

Printing a Report

In FuelsManager, you can print displayed or undisplayed reports.

Printing an Undisplayed Report
Open the Report Manager window using the previous instructions and then:

1. Do one of the following:

In the Dynamic Reports or Historical Reports task group, right-click a report name, and
then click Print.

Open the Report Select window, select a report, and then click Print.

Note The Report Select window only shows dynamic reports.
2. Confirm that the correct printer is selected.
3. Click Print.

Note For instructions for opening the Report Select window, see “Displaying a Report” on
page 53.

Printing a Displayed Report
Use these steps to print the active report display.

1. Do one of the following:

In the Dynamic Reports or Historical Reports task group, right-click on a report name,
and then click Print. The Print window appears.
Click the Print menu. The Print window appears.
If you are viewing a Historical Report, click the printer icon button on the report
toolbar.

2. Select the print options.

3. Click OK.
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Print to File

Selecting the ‘Print to File’ option allows you to store the report as a disk file in the project
directory as opposed to printing a hard-copy report.

1.  From the Print window, select ‘Print to File’.
2. Select OK. The Print to File window appears.

3. Enter a file name using a *.prn file extension (for example, TankFarmWest.prn).

Opening a Historical Report

To open a predefined historical report perform the following steps:

Note The operator can navigate through historical reports on screen using the scroll bars
or tool bar at the top of the window. They may also print the report using the icon on the
tool bar.

To open a historical report
1. Click Display menu from the menu bar.

2. Select Open.

3. Select Historical Reports. The historical reports submenu appears with a list of pre-defined
reports.

4. Select the report required from the submenu. The historical report window opens showing
the required data.

Command Summary

Command Description
Display Open Report (F3) Allows you to select a Real-Time report to open
Historical Reports | Displays a list of submenu commands that allow you
to open various types of reports, which will be listed
as submenus
Print Menu Only available when a report window is active -
Allows you to print the current report
Page Next Page Displays the next page of the currently displayed
(Ctrl + PgUp) report
Previous Page Displays the previous page of the currently displayed
(Ctrl + PgDn) report
Screen Down Scrolls down the current page of the currently
(PgDn) displayed report
Screen Up Scrolls up the current page of the currently displayed
(PgUp) report.
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8 Defining and Viewing Trends

Understanding Trends

A trend is a graph that shows how values change for some equipment in the fuel system over a
period of time. Traditionally, trends are produced with a strip chart recorder, but you can use
FuelsManager Operate to view trends on screen, and you can easily set up your own trends.

Trends are categorized by their scope (tank or generic) and by the time frame used (Real-Time
or Historical).

Real-Time and Historical Trends

Real-Time Trends provide current information from the moment the trend window is opened.
Historical Trends show how information changed between an operator-defined start and end
time.

Note For Historical Trends to be produced, FuelsManager Operate must have access to
historical data for the time specified.

Tank Trends and Generic Trends

Tank Trends

Tank Trends allow you to view one or more database point variables for a particular tank. For
example, a Tank Trend can track the tank level, temperature and gross volume of a single tank.
Tank Trends are only accessible from the Tank Detail window using the Detail menu.

There are two Tank Trends defined for your facility: a Real-Time Tank Trend and a Historical
Tank Trend. You can modify each definition, but you cannot define a new Tank Trend.

Generic Trends

Generic Trends provide access to one or more database point variables for one to four tanks or
other database points. This can be any point or variable from the configured database. For
example, a Generic Trend can show tank levels for four different tanks simultaneously.

You can define multiple Generic Trends. These trends are available on the Display menu.

Opening a Tank Trend

To view trend information for a single tank:

1. Open the Tank Detail for a tank.
2. Do one of the following:

On the Icon toolbar, select the Realtime Trend or Historical Trend icon. To locate the
icon toolbar, see “Work Area Elements” on page 3.

On the Detail menu, select Realtime Trend or Historical Trend, and then click Open.

3. A new window display appears showing the selected trend.
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Trend values Default slider Process range
over time bar position
Area Description
Pen Box The pen box allows you to view the cursor information at the slide bar
position within the display grid. You can change the pen attributes
temporarily by clicking in the pen box.
Time & Date The time and date area displays the time and date at the slide bar. In a
Real-Time trend, the Pause button freezes the display grid allowing you
to view a particular time and date.
Value Scale Value scale defines the vertical axis in value increments. The values are
drawn from the historical database and are displayed in decimal form.
You can set the Major and Minor Divisions for the vertical axis.
Time Bar Time bar defines the placement of the time axis. You can display the
time axis along the top and/or bottom of the grid by selecting the
desired option(s).
Display Grid The display grid gives you a graphical representation of what the tank
has done. The values are displayed in decimal form.
Slider Bar The slider bar allows you to display information at a particular time
within the display grid. The value for each pen is shown in the Cursor
field in the corresponding Pen Box.
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Opening a Generic Trend
Note Generic Trends can include parameters from different tank points or from any input/
output point.

1. On the menu bar, select Display > Open, and then select Real Time Trend or Historical
Trend. The Load Trend window opens.

Display

Index Display F1

Print Display Repart ... F3

Historical Reports »
WE Ta_g Se_als“' Tank Detail ... F7
Communications Tark Groupsn F
Exit Cperate Real Time Trend ...

m

1. If no generic historical trends have been defined for your site, the Trend Setup window will
appear. To set up a new trend, see “Creating a New Generic Tank Trend” on page 65.

Load Trend g|

FILENAME: DESCRIPTION:
Feceint Tanks bt Heceint Tanks - 30 dat

= ‘ Delete ‘ Edit | Open | o] ‘

2. Inthe Load Trend window, select the trend you would like to view, and then click the Select
button. A new window display appears showing the selected trend.

Opening a Real-Time Tank Trend

The most common trend operation is to open a Real-Time Tank Trend from a Tank Detail
window. With the required Tank Detail window open, follow these steps:

1. From the Menu bar select the Trend menu.
2. Open the Real-Time submenu.

3. Select Open. The Tank Trend window opens.

Configuring a Tank Trend for a Single Tank

Note Tank trends can only include tank point parameters for a single tank.

As an operator, you can define your own trends for a tank at your fuel facility. This example
shows how to modify the existing, pre-defined configuration for a Tank trend.
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Defining a Real-Time Trend

1. Open a Tank Detail view and click in the view.

2. On the Detail menu, select Real Time Trend > Configure. The Trend Definition window
opens.Type in a description of the trend.

3. Choose a style.
4. Define a time span.
5. Define a time bar.
6. Select the grid colors.
7. Define a value scale.
8. Select the open attributes using the steps below described in the ‘Selecting Pen Attributes’
section.
Note The trend filename, can have up to 35 characters and can be different from the trend
Description, which can have up to 30 characters. The files contain the .RTT file extension.
Trend Setup X
File: Pen 1
Point Mame :
Description ; TankFarm, Tank 1.Tank
[ TankFarm. Tank 1.Tank Vfgvagle : T
Style Time Span Penz
" Discrete Sample Rate [5 S(\E;;’é“ penz | [ w2
& Owerlappec & 5ac O Mint Hr Point Name §
Time Bar Grid Colars vl:gtf:"m‘wnk Lenk
s [ E:;t]l:;:;in p::n;uerature Delete
e |l | || e System : peng | [ with:
[~ Top ¥ Botton pe— ERE
SRS Paint Mame :
it D ,1— Major Divisions '1_” TankFarm, Tank 1.Tank
" Sec & Mn O Hr Minar Divisions 'T V;re‘:::t?v‘ Delete
Eemict ’—_‘F‘DW = I™ Left ¥ Right 2$Zt:m: Pent - Width:
Point Mame :
Save ... \ Ok \ Cancel UaiEtby S
Field/Section Description
Description Used to record a more detailed explanation of the trend. The

description appears in the Trends menu bar

Style (Discrete/ The Discrete Style option allows each pen to have a separate

Overlapped) window. The Overlapped Style option allows all pens to be plotted
in a single window.
Time Span Defines the time interval in which the system retrieves new data.

You can set the time interval of how often new data is added to
the trend in the Sample Rate field and the interval units in
seconds, minutes or hours
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Field/Section

Description

Time Bar

The Time Bar defines the horizontal axis in time increments.
You can set the Major and Minor Divisions for the horizontal
axis.

A Major Division is the number of Divisions that can fit in the
width of the Real-Time Trend window.

Minor Divisions are the # of cells in one Major Division. The
lines defining Major Divisions are thicker than the lines
defining Minor Divisions.

You can display the time along the top and/or bottom of the
grid by selecting the desired option(s).

Time/Maj Div. defines the length in time it takes to complete
one Major Division of the time bar. The number entered in
this field can be defined in seconds, minutes, or hours. For
example, entering 10 seconds for the Time/Maj Div entry
causes 10 seconds to complete one Major Division.

The Format defines the type of time format that the system
displays along the horizontal axis.

Grid Colors

Grid colors define the three system colors for the grid
Divisions and background.

Value Scale

Value Scale defines the vertical axis in value increments. The
values correspond to the real-time database and are
displayed in decimal form. You can set the Major and Minor
Divisions for the vertical axis.

A Major Division is the number of Divisions that can fit in the
height of the Real-Time trend window.

Minor Divisions are the # of cells in one Major Division. The
lines defining Major Divisions are thicker than the lines
defining Minor Divisions.

You can display the value on the right and/or left of the grid
by selecting the desired option(s).

Selecting Pen Attributes

The right side of the Real-Time Trend Definition window displays the settings for pens (Up to

four pens may be created). Each variable may have a unique pen color assigned for plotting.

Scales are drawn at the right vertical axis depending on the number of pens selected. Both the
scale and the range are color-coded to match the pen selected.

1. First, define a trend as described in the ‘Defining Real-Time Trends’.

2. Click on the Pen 1 button. The Pen Attribute window appears.

Dialog,

System :

MFME
Pairk Name :

TankFarm, Tark 1. Tark
Wariable

Density

Max Scale
Min Scale

Precision

Dats Setup Pen Color ¢

» «
100,000000000 e

" Red % Magenta

0,000000000  areen  Cyan

 Yellow  White I Eiled Trace

El it | pefine
oK

3

Penwidth: [z

Options ;

¥ Display Scale
[ Interpolate

Cancel

3. Choose Scaling parameters.

4. Choose Pen Color.
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5. Choose Pen Width.

6. Select Other Options.

7. Click OK. The changes are temporarily made to the Tank Trend displayed.

Field/Section Description

Scaling Defines the minimum and maximum range of the variable selected. The
initial values in this area are derived from the limits defined during
database configuration.

Pen Color Defines the color of the pen used when plotting the results on the screen.

Pen Width Pen Width defines the thickness of the line being plotted on the screen.

Options Other Options include selecting the trace style of the trend. The Filled
Trace produces a solid trace. The Display Scale is shown on the vertical
axis.

Changing the Point Variable for a Tank Trend Pen

Each pen within a Tank trend corresponds to a database point variable for that particular tank.
Pens may be modified to display different variables in the current trend, to do this follow the
steps below.

1.
2.

From the Pen Attributes window click Edit.

The Select Point Variable window appears. This window displays the choices appropriate for
this value: the type and variable.

Scroll through the list and choose a variable, then click OK. The Pen Attribute window
appears.

Confirm that the correct point and variable are displayed in the window and click OK.

Repeat the procedure for additional pens from the Real-Time Trend Definition window.

Defining Pen Attributes from a Trend Window

The operator is able to define Pen Attributes from the Trend window and during the editing or
creating a trend process.

1.
2.

From the Trend window click the colored Pen Title bar. The Pen Attribute window appears.

Make the selections for Pen Attributes based on options 2-5 described in the ‘Selecting Pen
Attributes’ section.

Click OK. The changes are temporarily made to the trend displayed.

Editing a Trend

To edit a Trend, perform the following steps:

1.

N o Vv ok WD

From the Menu bar, select Display.

Select the Open submenu.

Select Real-Time trend.

The Select Trend Definition window opens.

Highlight the desired filename.

Click Edit. The Real-Time Trend Definition window appears.

Choose the required selections.
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Many of the selections are similar to creating a new trend. Please reference the section
above.

When all changes are made, re-save the Trend file. You are also able to save this as a new
file.

Creating a New Generic Tank Trend

FuelsManager Operate provides you with the ability to customize and create their own trends.
In this example you can create a new Generic, Real-Time Trend.

1.

N o Vv ok WwWN

From the Menu bar select the Display menu.
Select the Open submenu.

Select Real-Time trend.

The Select Trend Definition window opens.
Select New.

The Real-Time Trend Definition window appears.

Modify, change and select all the entries as previously described for a Tank trend until it is
fully configured.

All changes are permanently made to this trend when it is saved.

Defining the Database, Point and Variable for a Pen

You can define the database, point and variable for each pen when you create or edit a trend.
Continuing from the procedure above, with the Select Trend Definition window open:

1.

Current Database System

WFME Active Levels: 3 Deilslgee...

Point Mame

Click a pen button (for example, Pen 1). The Database Edit window appears.

Database Edit E|

o
=

TankFarm —>Tank 1
[=Tank 2
[ Tank 3
[ Tank 4
I=Tank &
I»Tank &
[=Tank 7
[ Tank 8
ke Tank 9 Export...
[=Tank 10
leTank 11 Import ...
[~ Tank 12
> Tank 13

== Prev Level ‘ Cloze |

*
=

M

(=

H

Rename...

<

2.

The Select Database Point Variable window appears. In this window, you can define the
database, point and variable for the pen.
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3. Click on the Database button to select the DataManager. The Select DataManager Subsys-
tem window appears.

Select DataManager Subsystem [g|
System: ﬂiﬂi
DataManagers

WTESTWWEE

Display Options
v Show LAN Servers

[ Show TCPAP Servers

Select | Cancel

4. Click on the desired DataManager. The system highlights your selection and places it in the
System field.

5. Click Select. The Select Database Point Variable window appears.

6. Click the Point button. Choose the desired point name and click Select. The Database Edit
window appears.

Database Edit le

Current Database System
UFME Active Levels . 3 Database...

Paint Mame

m

clit

*

TankFarm .= Tank 1
= Tank 2
P Tank 3
> Tank 4 G-
= Tank &
> Tank B
= Tank 7
P Tank &
= Tank 9 Export...
= Tank 10
b Tank 11 (PSR
= Tank 12

B Tank 13 ha

== Prev Level | Cloze |

7. If these selections are correct click Select. The Pen Attributes window appears.

=

A S

=

Rename...

8. Modify the Pen attributes as detailed in the sections above, then Click OK. The Real-Time
Trend Definition window appears.

9. Modify, change, and select all the entries as previously described for a Tank trend until it is
fully configured. All changes are permanently made to this trend when it is saved.

Note In the Database Edit window you are able to browse through these levels by using
the <<Prev Level and Next Level>> buttons. The Select button is not enabled until the last
level is selected.
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Command Summary

Command

Description

Display

Open

Real-Time Trend

Allows you to select a Real-Time
(Generic) trend to open

Historical Trend

Allows you to select a Historical
(Generic) trend to open

Trend Menu

Only Available when a Tank Detail is
open

Trend

Real-Time

Displays a list of submenu commands

Open

Opens the currently configured Real-
Time trend for the selected tank

Configure

Allows you to configure the values for
the Real-Time trend

Historical

Displays a list of submenu commands

Open

Opens the currently configured
Historical trend for the selected tank

Configure

Allows you to configure the values for
the Historical trend
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9 Monitoring Product Movement

Note This is an optional feature. This feature is only available with FuelsManager Profes-
sional Edition.

FuelsManager’s Product Movement System is a software application for tracking product
movements in refineries and bulk storage facilities. This chapter provides the explanations,
instructions, and examples needed to understand and use the Product Movement system.

For explanations, see:

“Understanding Product Movement” on page 69
“Understanding the Movement Displays” on page 76

For instructions for using the system, refer to:

“Opening the Movement Displays” on page 77
“Using the Movement Displays” on page 81
“Creating and Copying Movements” on page 78
“Exporting and Importing Movements” on page 91
“Printing Movement Tickets” on page 91

For examples and a list of commands, see:

“Practical Movement Examples” on page 93
“Command Summary” on page 95

Before You Begin

It is assumed that the equipment required for moving product has already been installed and
commissioned at your facility. If there are questions concerning the status of any equipment,
please contact an administrator or supervisor before continuing.

Understanding Product Movement

A movement involves transferring product from one or more sources to one or more
destinations. The FuelsManager Product Movement system tracks tank-to-tank transfers,
charges, yields (rundowns), shipments, receipts, water drains and blends. It provides real-time
operational alarms when setpoints are approached and reached, and archives information
detailing the actual amounts of product transferred.

To understand product movements, you should understand:

“Product Movement Components” on page 70
“Product Movement Types” on page 70
“General Movement Terms” on page 73
“Product Movement States” on page 74
“Product Transfer (Xfr) Modes” on page 74
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Product Movement Components

Term Definition
Node A source or destination in a product movement.
Unit A node (see definition) that represents a physical object that has no

measuring device. Examples include Pipeline XYZ, Truck Rack 123, or
Pumphouse A2B. Units provide meaningful names for plant items used in
product movements.

Because a unit has no measuring device, it cannot monitor product
movement. You cannot enter movement setpoints for a unit, and
movements involving units will not calculate discrepancies.

Meter A node (see definition) in a product movement that contains the reading
from a physical meter. You can associate FuelsManager input and output
database points with meter nodes and have the meter data automatically
collected or manually entered.

Tank A node (see definition) that represents a tank point configured in the
FuelsManager System. A tank point includes predefined variables
specifically designed for tank gauging applications. Each tank provides
process values, or tank variables, which may be entered manually,
received from a field device or internally calculated.

Product Movement Types
There are seven types of product movements in the FuelsManager Product Movement system.
The following table defines each movement, and the following graphics describe each
movement visually.

You can also create combined movements by chaining together other movements.

Movement Types From (Sources) To (Destinations)
Blend One or More Tanks One Tank
Charge One Tank One Unit/Meter

(Typically, a refinery
processing unit)

Receipt One Tank Unit or Meter One or More Tanks, Meters

Run-Down One Unit or Meter One Tank

(Typically, a refinery
processing unit)

Shipment One or More Tanks or One Unit/Meter or Tank
Meters

Transfer One Tank One Tank

Water Drain One Tank One Unit/Meter
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Figure 9-1. Blend Movement

Figure 9-2. Charge Movement (to refinery processing unit)

L S

Figure 9-3. Receipt Movement (from meter node)
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=

Figure 9-4.: Receipt Movement (from unit - ship, barge, truck, or pipeline)

-

Figure 9-5: Run-Down Movement (from refinery processing unit)

Figure 9-6: Shipment Movement (to meter node)
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Figure 9-7:  Shipment Movement (to unit - ship, barge, truck or pipeline)

Figure 9-8: Transfer Movement

Figure 9-9: Water-Drain Movement (to drain or slops tank)

General Movement Terms

Term Description
Closeout Stopping of the movement (either manually OR due to non-zero
flow)

If the movement is active at the system specified closeout time
(default midnight)
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Term

Description

Opening Value

If a close out has occurred, the opening value is the value of the
particular variable at the last closeout time.

If the movement has been started but a closeout has not

occurred yet, the opening value is the value of the particular
variable when the movement started.

Closeout Value

Only exists after a closeout event has occurred. If the movement
remains active, and further closeout events occur the closeout
value will be updated.

Start Value The value of the particular variable when the movement was
initiated.
Combined Movement A combination of movements that involve one or more common

tanks. The following combinations are NOT allowed:
A combination that involves the same node pair twice.
A combination that results in a circular transfer of product.

Discrepancy

The difference between the total amount transferred from all the
From tanks and the total amount received at all the To tanks.

Totals

Only available for Shipment and Receipt movements and is the
sum of amount transferred.

Product Movement States

The following table shows the different states of movements.

Movement States

Description

Inactive

The movement has been setup but has not been initiated.

Pending

The movement has been setup but has not been initiated.

Movements must be set to Pending manually. Pending movements can
be sorted and filtered.

Active

The movement has been initiated and is not configured to use Start on
Non-Zero Flow.

Disabled

The movement cannot be initiated because one or more of the tanks
involved in the movement are currently in use by another movement
and this movement cannot be combined.

Halted

The movement has been paused. This can also occur if movement data
fails to write to the database during a Stop.

Failed

During the start-up of the movement a failure occurred, the movement
is neither active nor inactive. You must use the Reset menu option to
clear this state.

Starting

The movement has been initiated but the movement has been
configured to Start on Non-Zero Flow and no flow has been detected
yet.

Stopping

The movement has been configured to Stop on Non-Zero Flow and zero
flow has not existed for a time greater than the Zero Flow Hold Off
Value.

Product Transfer (Xfr) Modes

The transfer (or Xfr) mode refers to the measuring denomination you are using to
product movement.

measure the

Transfer Mode

Description

Xfr Level

A transfer that is completed when it reaches the defined Level
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Transfer Mode

Description

Xfr Volume A transfer that is completed when it reaches the Stop Total Volume

Xfr Diff Vol A transfer that is completed when it reaches the Stop Differential
Volume (change in volume)

Xfr Mass A transfer that is completed when it reaches the Stop Mass

Xfr Diff Mass

A transfer that is completed when it reaches the Stop Differential Mass
(change in mass)

[ ————

4— ICurrent Level

< JRequira-d End Level

Transfer by Level

< I Current Volume / Mass

<+ JRequired End Volume / Mass

Transfer by Volume
or Mass
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Transfer by
Differential Volume or
Mass

Understanding the Movement Displays

Enter the amount
of volume / mass
to be transfer
from the tank.

You can track movements in real-time using the Movement Summary display. You can view
stopped Movements for a specific date in the Movement History display.

Movement Summary Display

The Movement Summary display shows real-time movement data using a collapsible, sortable,
and filterable treeview. You can use this display to set up, initiate, monitor, and terminate
movement instances. You can also export movements from the display to a CSV file, and you
can import movements from a CSV file to the display.

The Movement Summary continues to display a movement’s data until it is either stopped or

deleted.

#1 FuelsManager - Operate

Column header

TN .»‘Eiﬁéiﬁ ool

EEX

abx

[ MoveType [ RowTypp |  Node

| Xfr Gross Volume | Xfr Net Volume |

Xfr Mass | Time Remaining

State | Xfr Setpoint_|

T8 Transfer Tom Tank 1 Inactive -5000.00
To Tank 8 500000
Receipt B182 Receipt From 300 Inactive
To Tank 3 8000.00
Tank 2 5000.00
Shipment G7. Shipment From Tank 17 Inactive  -10000.00
To M40
Movement _ T9-TI0 Transfer From Tank 9 Inactive -8000.00
node To Tank 10 8000.00
TBto T Transfer From Tank 8 Inactive  -10000.00
To Tank 9 1000000
Movernent 9 Transfer From Tank 1 Inactive 2000
Handgauge (from) Tank 1
To Tank 10 00
Handgauge (to) Tank 10
Movernent 11 Transfer From Tank 10 Inactive 2000
Handgauge (from) Tank 10
Tank 13 00
Handgauge (to) Tank 13
Movernent 18 Transfer Tank 11 Inactive -2000.00
L) RS I A N A N
Tank 13 200000
Handgauge (to) Tank 13
< 3
2

; Alarm Line

No UnAcknowledged Alarms

B DD o F @ ) rewesvonce

Administrator

8152005 1:14:19 PH0

76

User Manual



FuelsManager Oil & Gas

Movement History Display

The Product Movement system writes records to the Movement History database at the following
times:

When a movement is stopped, either manually or automatically on non-zero flow (if the
Stop on Non-Zero Flow option is selected).

If a movement is active at the system close out time. The default close out time is midnight
but can be configured to be any single time during the day. The close out time can also be
disabled.

You can open a Movement History display to view all closed product movements, with totals and
discrepancies, for any day you choose. The movements are shown in a collapsible/expandable
tree view so you can quickly scan many movements or view movement details. You can sort and
filter movements, and you can open multiple displays to compare movement history data from
different days.

The Movement History display does not show Closeout movements.

Column
header

8 200.100.200.42 - Remote Desktop 22205 105604 v ENENENEN [/

EEX

rts Took Help

SRENEEREI S NP RS NN (Y YRR o P, X DX D) |

L &7 | T UFMELTankFarm, TankiD-101 Tark | 93] () Movement History - 6/13/2005 | iz

Name | MoveType | RecordType |  MNode | StartTime | StopTime | StartLevel | CloseoutLevel | Xfr Gross Volume | Xfr NetVolun

Movement
row

Movement
node

< >

; Alarm Line 2

8ROV 48 % Tz

72212005 2:09:16 PM_ TankFarm.Tank 12.Tank Tank 12 Level High

Ready Administrator 712712005 10:57:47 AN [
| == Sl B leliee S T R A

Opening the Movement Displays

To open the Movement Summary Display

On the Movements menu, click Summary. The Movement Summary display appears.

To open a Movement History Display
1. In the Movements menu, click History. The Open Movement History window appears.

2. Select or enter the date. Click OK. The Movement History display appears.
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Creating and Copying Movements

To track product movement with FuelsManager, you must first define the movement paths by
creating a movement. You can then monitor the movement of product by starting a movement
instance.

You can create a completely new movement, as described below, or you can copy a movement
as described in “Copying a Movement” on page 80.

To create a Movement

1. On the Movements menu, click Summary. The Movement Summary display appears.

2. Do one of the following:

The Movement Setup window appears.

Movement Setup - Transfer
HName Group

[ Movement 9 [ ~|
Order #
Commert
Mewvements Interlocks
[~ Stopitalt based on Zero Flow j
¥ Delete After Complation O
[ Start Time based on Non Zero Flow W Interiock Saurce & Destination Setpoirts
o I~ Include Handgauge Yalues
r r
Movement Ticket
Movemert Ticket Name Ticket Printer

Mone= =] [reLaserets ~|
Movemerts

From To [ xfrmade setpaint | %
< >

Select the Movements menu in the Movement Summary display. Select New, and then
click on the desired movement type. The Movement Setup window appears.

Right-click on any area of the Movement Summary display. The Movement Summary
pop-up menu will appear. Select New and then click on the desired movement type.

3. Enter information or select options as appropriate. Each field is described in the following
table. At minimum, you must:

Enter a unique name for the movement
Set up movement source(s) and destination(s)

Field

Description

Name

Name lets you type in a specific name for the movement. When a new
movement is created from the New menu the system provides the
default Name in the form of Movement ###, where ### is a unique ID
number. When movement is initiated, this field is cleared.

Group

Group lets you type or select a group name for the movement, which
may be used to correlate multiple movements. Clicking the Group arrow
allows you to view all previously defined Groups and displays the
selection.

Order #

Order # lets you type in a specific movement order number used for
invoicing. Once a movement is initiated, this field is disabled.
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Field

Description

Input Point

Use this field to provide a database point for starting and stopping this
movement automatically. To apply this feature, you must select the Use
Input Point checkbox.

This makes it possible to start or stop a movement based on the value
set in a database input point. As the operator, you only need to monitor
the movement.

Consult your FuelsManager system administrator to determine if you
can use this feature.

Comment

You can enter information about the movement in this field, up to 200
characters in length.

Planned Start
Time

Select this checkbox and choose a start date and time to cause
FuelsManager to visually notify you when that time is approaching, and
when it is overdue. The start date and time that you enter also appears
on the main movement row in the Movement Summary display.

There are four warning stage colors and four overdue stage colors.
Defaults are yellow for warning and red for overdue.

Stop/Halt Based
On Zero Flow

Selecting this option allows the movement to automatically stop when
zero flow persists for the Stop Hold Off Time.

Zero Flow Hold
Off Time (Min.)

Zero Flow Hold Off Time defines the time the Zero Flow must persist
before the system automatically stops the movement. This field is
enabled only when Stop Based on Zero Flow is selected.

If the movement consists of multiple Source and Destination tanks,
Zero Flow must persist for all tanks.

Delete After
Completion

Selecting this option allows the system to automatically remove the
movement from the summary after the movement is stopped.

Source Setpoints
Specified In
Percent

Selecting this option displays the Transfer Setpoint for Source Nodes in
percent. This field is enabled only for Blend movements.

Start Time Based
On Non Zero Flow

Selecting this option ensures that the Start Time recorded for the
movement will be the time at which a flow was first detected, not the
time at which the movement was initiated.

Interlock Source
And Destination

Selecting this option causes changes in either source or destination
setpoint to be automatically reflected in the corresponding destination

Setpoints or source.

Use Pending Select this checkbox to set the Status field for this movement to

Status Pending. This makes it possible to use a filter to limit the display to only
Pending movements, or Pending and Active movements.
When the movement is started, the pending status is replaced with the
appropriate Status code.

Include Selecting this option creates a handgauged node for every tank node

Handgauge involved in the movement. Use this option when you are required to

Values enter handgauged results for the movement.

Use Input Point
Start/Stop

Select this field to start and stop this movement using the
FuelsManager database. If you select this checkbox, you must select a
valid database point in the Input Point list in this window.

This makes it possible to start or stop a movement based on the value
set in a database input point. As the operator, you only need to monitor
the movement.

Consult your FuelsManager system administrator to determine if you
can use this feature.

Individual Node
Control

Selecting this option gives you the ability to start and stop tanks in an
active movement independent of stopping the movement. This option
is only available for Receipt, Shipment, and Blend movement types.
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Field

Description

Send to Snap In

This option is only available if a Snap In is installed.

This option is used to communicate FuelsManager Product Movement
data to other software systems. Selecting this option causes the
following to occur (if the required programming steps have been
taken):

When the movement is stopped, the movement data is sent to all Snap-
Ins registered on this client system. Snap-Ins are COM interfaces that
are programmed to use the data. So administrators in your company
could use a Snap-In to send product movement data for each stopped
movement, to their accounting system.

(Movement
Ticket) Name

Select the report that you want to be automatically printed when this
movement is complete. For manual movement ticket printing please see
the ‘Movement Tickets’ section.

(Movement
Ticket) Printer

Select the destination printer for the selected Movement Ticket report.

From

Select the source(s) as determined by the movement type.

To

Select the destination(s) as determined by the movement type.

Xfr Mode

Select one of the following modes:
Xfr Level
Xfr Volume
Xfr Diff Vol (Differential Volume)
Xfr Mass
Xfr Diff Mass (Differential Mass)

Setpoint

Set the amount to be transferred from the Source tank into the
Destination tank or the amount to be transferred from the Destination
tank to the Source tank.

Setpoint units depend on the Xfr Mode and the units of the tank
selected. The system only allows setpoints for Source or Destination
tank points.

The system automatically converts the setpoint when changing between
different Xfr Modes.

The % is only available to Blend movements, and then only if the Source
Setpoints Specified in Percent check box is selected. When enabled, you
can enter the destination and source setpoint and enter the source
setpoints in percentage, for example 80% and 20%.

Units

The Units lists the units associated with the Xfr Mode selection.

Min. and Max.
and Reference
Volume

This area shows the valid range for the Setpoint or % based upon the
cell selected in the movements frame. The Min. and Max. values are
only visible when a setpoint cell is selected. Reference volume is only
visible for Xfr by Diff. Vol and indicates the current tank volume to
which the diff. volume setpoint will be relative to.

4. Click OK. The system displays the information on the Movement Summary display.

Copying a Movement

You can copy a movement shown in the Movement Summary display to create a new movement
with a different name.

To copy a movement

1. In the Movement Summary display, right-click on the top row of the movement that you
want to copy. The Movement Summary pop-up menu appears.

80

User Manual



FuelsManager Oil & Gas

2. Click Copy. The Enter Movement Name window appears.

3. Enter a new, unique name for the new movement, and then click the OK button. The new
movement appears in the Movement Summary display.

Using the Movement Displays

Accessing the Movement Summary Menu

Right-click anywhere in the Movement Summary display to show the Movement Summary menu.
Where you click in the display determines which commands appear on the menu and which
commands are available.

Accessing the Movement History Menu

Right-click anywhere in the Movement History display to show the Movement History menu.

Where you click in the display determines which commands appear on the menu and which
commands are available.

Working with the Treeview

To collapse or expand a Single Movement
In the Movement Summary or Movement History display, click the + or - symbol to the left
of the movement name. The movement is collapsed or expanded.

To collapse All Movements
With a Movement Summary displayed, do one of the following:

In the Movement Summary display, right-click in an empty area of the display. On the
pop-up menu, click Collapse All.

On the Operate menu bar, select the Movements menu, and then click Collapse All.

All movements in the display are collapsed to show movement header rows only.

To expand All Movements
With a Movement Summary displayed, do one of the following:

In the Movement Summary display, right-click in an empty area of the display. On the
pop-up menu, click Expand All.

On the Operate menu bar, select the Movements menu, and then click Expand All.

All nodes are shown for each movement in the display.

Working with Columns
When you create a Movement Summary or Movement History display, it includes default columns
automatically. If you have the appropriate authority, you can change the display to show
different columns by using the following procedures.

To move a Column

Use this procedure to drag a column in the display to a different position. You can move any
column except the Name column.
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1. In the Movement Summary or Movement History display, click on the column header, hold
down the mouse button, and drag the column header to a different place in the heading
row.

2. When the colored arrows indicate the correct location, release the mouse button. The col-
umn is moved to the new location.

To add a Column

Use this procedure to add a column of your choice to the far right side of the Movement
Summary or Movement History display.

1. In the Movement Summary or Movement History display, right-click on any column head-
ing. The pop-up menu appears.

Click Add Column. The Select a Column window appears.
Click the down arrow. A drop-down menu appears.
Select the new column heading in the list.

Click OK.

v M WN

To insert a Column

Use this procedure to insert a new column to the left of the currently selected column. You can
perform this action on any column except the Name column.

1. In the Movement Summary or Movement History display, position the cursor to insert the
new column.

2. Right-click on the column heading. The pop-up menu appears.
3. Click Insert Column. The Select a Column window appears.

4. Click the down arrow. A drop-down menu appears showing columns that are not currently
included in the display.

Select the new column heading in the list.
6. Click OK. The system inserts the new column heading and its data to the left of the currently
selected column.

To replace a Column

Use this procedure to replace a column with a different column of your choice. You can perform
this action on any column except the Name column.

1. In the Movement Summary or Movement History display, right-click on the desired column
heading. The pop-up menu appears.

Click Modify Column. The Select a Column window appeatrs.
Click the down arrow. A drop-down menu appears.

Select a new column heading from the list.

v M WN

Click OK. The system replaces the column heading and its data with the new selection.

To delete a Column

Use this procedure to remove a column from the display. You can delete any column except the
Name column.

1. Inthe Movement Summary or Movement History display, right-click on the desired column
heading. The pop-up menu appears.

2. Click Delete Column. The system displays message: ‘Delete column: Level’.
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3.

Click OK. The system deletes the column from the Movement Summary or Movement His-
tory display.

To enter a Column Alias

You can change the column headings by using aliases. The original column name is retained by
the system, but the name that you choose is displayed.

1.

On the Movement Summary or Movement History display, right-click the column heading
to enter an alias. The pop-up menu appears.

Select Alias Column. The Column Header Alias window appears.

Enter the alias and click OK. The system closes the window and replaces the old column
heading with the alias. Click reset to return the column heading to its original name.

Using Movement Filtering

To filter Movements

You can filter movements in the Movement Summary or Movement History display to limit the
display to movements that meet the criteria that you select.

Columns that display numeric and time/date related data, such as Temperature and Xfr Gross
Volume, cannot be filtered.

1.

In the Movement Summary or Movement History display, right-click on the desired column
heading. The pop-up menu appears.

Click Filter. The Column Filter window appears.
Select the desired item or items that are to be displayed from the Do Not Display list.

Click the > button (right arrow). The system moves the selected item(s) to the Display list.
Click >> button to move all items from the Do Not Display list to the Display list.

Click OK. The selected movement or movements are shown in the Movement Summary or
Movement History display.

Filtered columns are denoted with an asterisk in the column heading.

To remove a Column-Specific Filter

1.

In the Movement Summary or Movement History display, right-click on the desired column
heading. The pop-up menu appears.

Click Remove Filter. The filtered item or items display on the Movement Summary or Move-
ment History display.

Note Filtered columns are denoted with an asterisk in the column heading.

To showing All Movements

1.

2.

In the Movement Summary or Movement History display, right-click on the grid area. The
pop-up menu appears.

Click Show All. The system displays all information.

Sorting Movements

You can sort movements by column values in the Movement Summary or Movement History. You
can sort movements at the top level, but you cannot sort movement nodes (details).
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To sort by Column
To sort by choosing ascending or descending order:

a. Inthe Movement Summary or Movement History display, right-click on the appropriate
column header.

b. On the pop-up menu, select Sort Ascending or Sort Descending. The movement is
sorted by this column in the order you specified.

To sort automatically, based on the current sort state:

In the Movement Summary or Movement History display, click on the appropriate
column header. The movement is sorted by this column in ascending or descending
order.

To clear the Sort

1. In the Movement Summary or Movement History display, right-click on the grid area. The
pop-up menu appears.

2. Click Clear Sort. The system returns back to the original display.

Increasing or Decreasing Text Size

To increase the Font Size
You can increase the size of text on the Movement Summary or Movement History display.

1. Right-click on any area of the Movement Summary or Movement History display. The pop-
up menu will appear. Select Increase Font. The system increases the font size throughout
the Movement Summary or Movement History display.

2. Repeat this step until the desired font size.

Note The Product Movement System has a maximum font size. Attempting to increase the
font beyond this limit will have no effect.

To decrease the Font Size

1. Right-click on any area of the Movement Summary or Movement History display. The pop-
up menu will appear. Select Decrease Font. The system decreases the font size throughout
the Movement Summary or Movement History display.

2. Repeat this step until the desired font size.

Note The Product Movement System has a minimum font size. Attempting to decrease the
font beyond this limit will have no effect.

To toggle Grid Lines On and Off

1. Right-click on any area of the Movement Summary or Movement History display. The pop-
up menu will appear.

2. Select Grid Lines. The system displays or hides the grid lines in the Movement Summary or
Movement History display.

To refresh the Movement History Display

A refresh causes the Movement History to re-load the information for the selected day from the
history database. Only the current Movement History can be refreshed. This option shows
movements that have been completed since the Movement History was opened.

1. In the Movement History display, right-click on the grid area. The Movement History pop-
up menu appears.

2. Click Refresh.
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Changing the Status of a Movement

This section describes how you can initiate (start) a movement or movement node to begin the
monitoring process. It also describes how to stop a movement or movement node, reset a
movement, hold a movement for manual values, enter manual values, and restart a movement.

To ilnitiate a Movement

To start the monitoring process for a movement, you initiate the movement. You can initiate
movements that are in the Inactive or Starting mode.

Note If the movement was setup to Start Based on Non-Zero Flow, Starting displays under

State column. When a flow is detected it changes to Active.

1. In the Movement Summary display, right-click on the movement row. The Movement Sum-
mary pop-up menu appears.

2. Click Initiate Movement. The system activates and displays Active or Starting in the State
column for the associated movement.

To initiate a Movement Node

In some situations, you may want to start and stop individual nodes in a movement. For
example, for a shipment to multiple tanks, you can initiate the movement for each tank node as
that tank is filled.

You can initiate movement nodes that are in the Inactive or Starting mode, if the movement was
set up to enable this feature. The Individual Node Control checkbox must be selected in the
Movement Setup window, as described in “To create a Movement” on page 78, or “To modify a
Movement Setup” on page 89.

If you can initiate a movement node, you can also stop a movement node, as described in below.

1. In the Movement Summary display, right-click on the movement node that you want to ini-
tiate. The Movement Summary pop-up menu appears.

2. Click Initiate Node. The system activates the node and displays Active or Starting in the
State column for the associated node.

To stop a Movement
You can stop movements that are in the Active, Starting, or Stopping mode.

1. In the Movement Summary display, right-click on the movement row. The Movement Sum-
mary pop-up menu appears.

2. Click Stop. The system displays message: ‘Verify stop of selected movement’.

3. Click Yes. The system stops and displays Inactive in the State column for the associated
movement.

To stop a Movement Node

In some situations, you may want to start and stop individual nodes in a movement. For
example, for a shipment to multiple tanks, you can stop the movement for each tank node as
that tank is filled. This section describes how to stop a movement node.

You can stop movement nodes that are in the Active, Starting, or Stopping modes, if the
movement was set up to enable this feature. The Individual Node Control checkbox must be
selected in the Movement Setup window, as described in “To create a Movement” on page 78, or
“To modify a Movement Setup” on page 89.

1. In the Movement Summary display, right-click on the movement node that you want to ini-
tiate. The Movement Summary pop-up menu appears.
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2. Click Stop Node. The system stops the movement node and displays Inactive in the State
column for the node.

To reset a Movement
You can reset a movement that is in a Failed state.

1. In the Movement Summary display, right-click on the movement row. The Movement Sum-
mary pop-up menu appears.

2. Click Reset. The system resets all default parameters and sets the movement to Inactive in
the State column for the associated movement.

To hold for Manual Values
Holding for Manual Values lets you pause a movement that is in an Active or Starting mode.

1. In the Movement Summary display, right-click on the movement row. The Movement Sum-
mary pop-up menu appears.

2. Click Hold For Manual Values. The system pauses and displays Halted in the State column
for the associated movement.

To enter Manual Values (Net or Gross Volume, Mass)

After a movement has been set to Hold for Manual Values, you can enter the meter reading.

Note You can also enter manual values for Active movements.

1. In the Movement Summary display, right-click on the movement that is holding for the
manual values. A pop-up menu appears.

2. Select the measurement that the meter node is set to display. This includes Set Gross Vol-
ume, Set Net Volume, or Set Mass. A window appears, prompting to enter the selected
amount.

3. Enter the meter reading and click OK. The system returns to the Movement Summary dis-
play, updates the fields, and calculates the discrepancy.

Modifying Movements

Editing Movement Startup and Closeout Data

After you create and initiate a movement, you can change the starting or closing data for each
source or destination in the movement. This applies to tanks or meters, but not to units, which
are not associated with data.

This may be necessary if, for example, you know that a tank gauge provided inaccurate level
data, or a manually entered value was incorrect.

This sections includes the following procedures:

“To edit Tank Start Data” on page 87
“To edit Meter Start Data” on page 88
“To edit Tank Close Out Data” on page 88
“To edit Meter Close Out Data” on page 89
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To edit Tank Start Data

For tanks, you can manually change the Start Time, Level, Gross Volume, and other quantity
data, or you can cause FuelsManager to use movement data stored in the Archive database.

1. In the Movement History display, right-click the source or destination tank row that you
want to change. The Movement History pop-up menu appears.

2. Select Edit Start Data. The Edit Start Data window appears.

|ledit start Data [=]

Dists: [ Bzom0i0 =]
Tirme: [ 33500 PM —=

I~ et Data From rchive
Level [z1-10o01 tin-1Bth
Temperature:  [31.200000 | oF
Gross Volume: [7858.635417 | gal (US)
Met Volume:  [4335.039844 | gal (US)
Mass: [s8141 678977 b

Density:

Std Density:

BS &wy. I 0000000 Percent

3. Enter values or select the fields as appropriate. The following table describes each field:

Field Description
Date Displays the start date.
Time There are two reasons to change the start time:

If you know that the date and time shown are incorrect, but you will
not select the Get Data From Archive checkbox.

To refer to a movement started at the time and day you specify, or
before. To do this, you must also select the Get Data From Archive

checkbox.
Get Data From If you select this checkbox, FuelsManager will search the Archive
Archive database to locate the selected node’s historical data at the date and

time entered in the Time field. If the search is successful, the data from
that historical data field will be used, and all of the movement data will
be recalculated.

If historical data for the selected node for the specified date and time
does not exist, FuelsManager will search backwards until it finds one,
and prompt you to accept the movement. If you accept, the start data
from that movement will be used, and the movement data will be
recalculated.

Selecting this option disables the Data fields.

Data Edit the values as appropriate in the Level, Temperature, Gross Volume,
Net Volume, Mass, Density, Std Density, or BS & W (Bottom, Sediment,
and Waste) fields. For more information about tank values, see “Tank
Detail Field Descriptions” on page 29.

4. Click the OK button.
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To edit Meter Start Data

For meters, you can manually change the Start Time, Gross Volume, Net Volume, and Mass, if
that data is available for the meter.

1. In the Movement History display, right-click the source or destination meter row that you
want to change. The Movement History pop-up menu appears.

2. Select Edit Start Data. The Edit Meter Start Data window appears.

Edit Meter Start Data
Time: ,m
Gross Volume: [p.ng
Net Volume: ’07
Mass: ,07

Cancel |

3. Change the entries in the Time, Gross Volume, Net Volume, and/or Mass fields as appro-
priate.

4. Click the OK button.

To edit Tank Close Out Data

For tanks, you can manually change the closing Time, Level, Gross Volume, and other quantity
data, or you can cause FuelsManager to use movement data stored in the Archive database.

1. In the Movement History display, right-click the source or destination tank row that you
want to change. The Movement History pop-up menu appears.

2. Select Edit Close Out Data. The Edit Close Out Data window appears.

3. Enter values or select the fields as appropriate. The following table describes each field:

Field Description
Date Displays the start date.
Time There are two reasons to change the start time:

If you know that the date and time shown are incorrect, but you will
not select the Get Data From Archive checkbox.

To refer to a movement started at the time and day you specify, or
before. To do this, you must also select the Get Data From Archive

checkbox.
Get Data From If you select this checkbox, FuelsManager will search the Archive
Archive database to locate a movement started at the date and time entered in

the Time field. If the search is successful, the data from that movement
will be used, and all of the movement data will be recalculated.

If a movement for the specified date and time does not exist,
FuelsManager will search backwards until it finds one, and prompt you
to accept the movement. If you accept, the start data from that
movement will be used, and the movement data will be recalculated.

Selecting this option disables the Data fields.

Data Edit the values as appropriate in the Level, Temperature, Gross Volume,
Net Volume, Mass, Density, Std Density, or BS & W (Bottom, Sediment,
and Waste) fields. For more information about tank values, see “Tank
Detail Field Descriptions” on page 29.
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4. Click the OK button.

To edit Meter Close Out Data

For meters, you can manually change the movement close Time, Gross Volume, Net Volume, and
Mass, if that data is available for the meter.

1. In the Movement History display, right-click on the source or destination meter row that
you want to change. The Movement History pop-up menu appears.

2. Select Edit Close Out Data. The Edit Meter Close Out Data window appears.

3. Change the entries in the Time, Gross Volume, Net Volume, and/or Mass fields as appro-
priate.

4. Click the OK button.

To modify a Movement Setup

You can modify the movement setup for movements with the following statuses: Active, Inactive,
Disabled, Starting, Stopping, or Halted.

1. In the Movement Summary display, right-click the movement row desired in the grid area.
The Movement Summary pop-up menu appears.

2. Click Setup. The Movement Setup window for the associated movement type appears.
3. Make the appropriate changes.
4. Click the OK button.

To delete a Movement
You can delete the movements that are in the Disabled or Inactive mode.

1. In the Movement Summary or Movement History display, right-click the movement row
desired in the grid area. The pop-up menu appears.

2. Click Delete. The system deletes and removes the associated movement from the Move-
ment Summary or Movement History display.

To edit Movement Values Directly In a Display

You can change some data in a movement directly on the Movement Summary or Movement
History display. This is called in place editing.

You can edit the following data fields in place: Comment, Order No, and User Def String1 to User
Def String10.

1. In the Movement Summary or Movement History display, double-click on the data that you
want to change. The data must be in the movement header row, not in a node row.

2. Make the correction.

3. Click in another location on the display.

To enter User String Data

You can enter and store user data to a movement using the Movement Summary display. This
feature allows you to store any string of data or information that is needed while that movement
is active.

1. In the Movement Summary display, select one of the rows in the movement.

2. Right-click the selected row. The Movement Summary pop-up menu will appear. Select
User Data. The User Data window appears for the selected movement.
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3. Enter any of the necessary data and click OK. The system attaches this data to the move-
ment.

Note Open the User Data window again to view the information stored.

To enter Handgauge Values

You can enter the results of a handgauge measurement into the Handgauge (from) and
Handgauge (to) nodes.

1. In the Movement Summary or Movement History display, right-click over the Handgauge
(from) row for the movement where values are to be entered. The pop-up menu appears.

2. Select Edit Handgauge Values. The Handgauge Data window appears for the selected node.

3. Inthe Process Data grid, enter the values from the handgauge. The results of the values
entered in the Process Data section are automatically calculated and displayed in the Cal-
culated Value Section.

4. After entering all handgauged values, click OK.

To toggle Automatic Values

You can toggle a movement to show and hide the automatic values. If the automatic values are
hidden, only the handgauged values appear.

1. In the Movement Summary display, right-click any of the rows in the movement. The Move-
ment Summary pop-up menu appears.

2. Select Automatic Values. The rows with the automatic values disappear or appear.

To toggle Handgauged Values

You can toggle a movement to show and hide the handgauged values. If the handgauged values
are hidden, only the automatic values will appear in the Movement Summary display.

1. In the Movement Summary display, right-click any of the rows in the movement. The Move-
ment Summary pop-up menu appears.

2. Select Handgauge Values. The rows with the automatic values disappear or appear. Hand-
gauged values only appear if the checkbox Include Handgauge Values was checked in the
Movement Setup window.

Note You cannot have both the handgauged and automatic values toggled off at the same
time. If the handgauged values are hidden, make sure that the automatic values are visible.

To view Discrepancies in Percentages

The Movement System defaults to showing any discrepancy in the Movement Summary display
in amounts. You can change this to show discrepancies by percentages.

1. In the Movement Summary display, right-click any of the rows in the movement. The Move-
ment Summary pop-up menu appears.

2. Select Discrepancy as Percentage. The Volumes and Mass columns switch to percentages.

Note To view the amounts again, just follow the same two steps.
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Exporting and Importing Movements

You can export all movements from the Movement Summary to a CSV file. You can then import
the movements from the CSV file. This can serve as a convenient method for backing up your
movement definitions.

You can also edit movements directly in the CSV file. The changes appear after you import the file.

To export Movements

1. In the Movement Summary display, right-click on a blank row or column header, and then
select Export Movements. You can also select Export Movements on the Movement menu.

2. Inthe Export Movement Data window, navigate to the directory to save the CSV file in, and
enter a file name. You do not need to include the file extension.

3. Click Save.

To import Movements
CSV files containing active movements cannot be imported.

1. In the Movement Summary display, right-click on a blank row or column header, and then
select Import Movements. You can also select Import Movements on the Movement menu.

2. In the Import Movement Data window, navigate to the directory in which the CSV file is
located, and then select the CSV file to import.

3. Click Open. The movements defined in the CSV file are now shown in the Movement Sum-
mary display.

Printing Movement Tickets

Note The format and types of movement tickets available at the load faculty are config-
ured by the Administrator or Supervisor. This section details the pre-packaged movement
tickets.

In the Movement History display, you can print movement tickets that contain summaries of
product movements. The movement tickets are general movement reports and can be applied
to any movement type. There are four different movement tickets.

Movement Gauge Only

Movement Gauge-Handgauge Only (for example, see page 93)

Movement Handgauge Only

Product Movement (for example, see page 93)

Most movement tickets display the following data:

Movement Name

Movement Initiation Time

Product

Movement Type
Ticket reports also contain a table that lists the different points and displays the following fields
from each point from the Opened and Closed date and time.

Node

Status

Product Level
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Temperature

Water Level

Standard Density

Gross Volume

Net Volume
Net Volume

Transferred

Total Discrepancy
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Product Movement Report

by Movement Type

Product:
Receipt
Movement Name:  Movement 9 Time: 10:19:34AM
Product: Movement Type: Receipt
Order Number: Prod Level BSW Level Temp Net Vol Xfer Net Vol
From  Pipeline 3
Opened: 09/26/2006 10:05
Closed: 09/26/2006 10:19 0.00
Units
Comment: Discrepancy:
Units
Product: GAS
Receipt
Movement Name:  Movement 9 Time: 10:19:34AM
Product: GAS Movement Type: Receipt
Order Number: Prod Level BSW Level Temp Net Vol Xfer Net Vol
To 1
Opened: 09/26/2006 10:05 11-00-00 0-00-00 77.00 2,750.00
Closed: 09/26/2006 10:04 21-00-00 0-00-00 77.00 5,250.00 2,500.00
Units ft-in-16th ft-in-16th °F gal (US) gal (US)
To 2
Opened: 09/26/2006 10:14 11-00-00 0-00-00 77.00 2,750.00
Closed: 09/26/2006 10:19 21-00-00 0-00-00 77.00 5,250.00 2,500.00
Units fi-in-16th fl-in-16th °F gal (US) gal (US)

Comment:

Discrepancy:
Units

gal (US)|

To preview a Movement Ticket Before Printing

1.
2.

3.

In the Movement History display, select the movement instance that is to be previewed.

On the Movement History pop-up menu, click Print Preview Ticket and select the ticket to

be previewed.

The ticket will display as a report that you can preview.

To print a Movement Ticket

1.
2.

In the Movement History display, select the movement instance that is to be printed.

On the Movement History pop-up menu, click Print Ticket and select the ticket to be

printed.

Select the correct printer and options in the Print Setup window.

Click OK. The system prints the movement ticket.

Practical Movement Examples

Example 1 — Simple Tank Transfer

Create a new movement of type Transfer.

Select the required Source Tank and the required Destination Tank.

Select the required transfer mode and enter the level, volume or mass value for the move-

ment to stop for either the source or destination tank.

Initiate the transfer, the Product Movement System will capture the starting tank data values
and show the movement as Active on the Movement Summary.
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You can monitor the progress of the transfer in the Movement Summary. In particular the
summary screen shows the amounts already transferred, the estimated time to complete
the transfer and any discrepancy between the amount transfer out of the source tank and
the amount received in the destination tank.

As the transfer nears its completion the Product Movement System will provide a warning
alarm a short time before the ending setpoint.

When the transfer is complete the Product Movement System will provide a shutdown alarm
indicating that the requested amount of product has been transferred from the source tank.
Stop the transfer, the Product Movement System will capture the stop values and final dis-
crepancy data.

The transfer data for this movement has been archived in the Movement History database
and can now be viewed in the Movement History.

Example 2 — Product Receipt

N

Create a new movement of type Receipt.

Select the required Source Unit and the required Destination Tanks. A unit is simply a name
given to the source of the product transfer (i.e. Dock, Truck Rack, Ship etc.). You can select
multiple tanks as the destinations; the Product Movement System will track the product
receipt in all selected tanks simultaneously.

Select the required transfer mode and enter the level, volume or mass value for the move-
ment to stop for each of the destination tanks.

Initiate the receipt, the Product Movement System captures the starting tank data values
and shows the movement as Active on the Movement Summary.

You can monitor the progress of the receipt in the Movement Summary. In this example
there is no discrepancy row displayed. This is because the source of the receipt is a unit
node and therefore has no measurement device. Discrepancies can only be calculated when
there is a measurement device on both the source and destination nodes.

The receipt movement shows a total row. This row sums the total amount of product
received in each of the tanks.

Typically operations will run the receipt into one of the destination tanks then switch over
to the other. The Movement Summary will provide independent warning and shutdown
alarms for each of the destination tanks, allowing you to administer the switch-over pro-
cess.

When all of the destination tanks have reached their shutdown setpoints stop the receipt.
The Product Movement System will capture the stop values and final totals data.

Example 3 — Shipment via a Meter Node.

To create a new movement of type Shipment

1.

Select the required Source Tanks and Destination Meter Node. A meter node is a movement
node containing a measurement device that can be manually or automatically updated. You
can select multiple tanks as the source for a shipment; the Product Movement System tracks
the shipment from all selected tanks simultaneously.

Select the required transfer mode and enter the level, volume or mass value for the move-
ment to stop for each of the source tanks.

Meter nodes can be configured to reset the volume or mass values when the movement
starts (able to be reset) or to accumulate the values until a rollover point is reached. In the
example we will assume the meters are able to be reset.

Initiate the shipment, the Product Movement System will capture the starting tank data val-
ues, reset any meter node volume or mass data to zero and show the movement as Active
on the Movement Summary.
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You can monitor the progress of the shipment in the Movement Summary. Since the ship-
ment has a measurement device at both the tank and meter nodes a discrepancy row is
shown on the Movement Summary. This row shows the difference between what has been
transferred out of the source tanks and what has passed through the meter.

If the meter data is being manually updated, you should expect the discrepancy to be large
until the meter data is updated. Electing to update the meter values periodically over the
span of the shipment, say hourly, provides consolidation information the may be useful in
the early detection of leaks or incorrect line-ups.

As with example 2 above the Movement Summary provides independent warning and shut-
down alarms for each of the source tanks.

When all of the source tanks have reached their shutdown setpoints select “Hold for Manual
Values’. This action halts the movement and allows you to enter the final meter volume or
mass data.

Once the final meter data has been entered, stop the shipment. The Product Movement Sys-
tem will capture the stop values and final meter data.

Command Summary

Command Description

Movements Summary Displays the real-time movement data.

Movements History Displays all product movements, totals, and
discrepancies on a daily basis.

Varec, Inc.
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10 Using Leak Detection

FuelsManager Leak Detection is a utility that you can use to monitor the data in your
FuelsManager system for leak conditions and to provide alarms for potential environmental
hazards.

Note This is an optional feature. This feature is available with FuelsManager Standard or
Professional Editions.

Understanding Leak Detection

FuelsManager Leak Detection basic functions include:

Monitoring level, temperature, water level and density from field instruments or operator
entry.

Performing analysis of sensor data, looking for conditions that might indicate a leak.
Comparing instrument readings and calculations against alarm limits.

Annunciating, processing and logging alarms.

Providing reports.

Leak Detection reads data directly from historical data, applying filtering algorithms, calculating
various statistics and applying qualifying logic. Alarm processes running within the systems
database can monitor the resultant calculations. This includes data manually entered, data
calculated in real-time and data received via communication interfaces.

Leak Detection’s primary objective is to detect a leak at rates as low as 0.2 gallons per hour. The
ability to detect leaks at these rates depends upon the physical characteristics of the tank (size,
shape, above/below ground, materials used in construction, etc.), the types of instruments
available to measure the properties of the product in the tank, the resolution and stability of the
instruments and how the tank is used.

Tank Analysis Methods

Leak Detection integrates with third party leak detection systems and instrumentation to detect
and calculate leaks based on:

Volumetric Analysis

Mass Analysis

Volumetric Analysis

Note Leak Detection detects leak rates as low as 0.2 gallons per hour for tanks up to
75,000 gallons.

Volumetric analysis requires measuring the level and temperature, calculating the net volume,
analyzing the tank data during periods of inactivity and searching for losses.

The Tank Analysis Method is determined by the configuration of the database point. As an
operator, you do not choose the method. The two volumetric analysis methods are Net Volume
and Unrounded Net.

Detection of leaks in bulk storage tanks using volumetric changes depends upon a number of
factors, including the dimensions of the tank and the Net Standard Volume derived from the
level and temperature.
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The resolution, stability and accuracy of the level and temperature instruments determine the
effectiveness of utilizing the volumetric analysis method. An accurate gauge with high
resolution yields the best results for static measurement. The accuracy of the tank strapping
table will also affect the accuracy of the volume calculation. Errors in the strapping table could
appear as leaks.

Some factors have more influence than others, depending upon the application. In large tanks
(over 50,000 gallons), the resolution of the level measurement is the limiting factor. For
example, for a 1,000,000-gallon cylindrical tank, 40 feet in height, a sixteenth of an inch (1/
16”) equates to almost 150 gallons. This means that a long time period is needed to effectively
detect a leak. Another limiting factor is the resolution and stability of the temperature sensor.
Changes in both the product and the tank shell temperature will affect the volume of the product
in the tank.

Mass Analysis

Note Leak Detection is certified on tanks up to 3,000,000 gallons for mass analysis.

Mass analysis is based upon measuring the pressure of the product and applying the
conservation of mass principle. In bulk storage tanks, the Total Observed Volume will fluctuate
with changes in the temperature of the product. The mass of the product in the tank is constant,
so changes in the temperature of the product have no effect on the total mass in the tank.

The Tank Analysis Method is determined by the configuration of the database point. As an
operator, you do not choose the method. The mass analysis method is Barton Series 3500.

Level Probes

Note All probes used for analysis are approved by an independent third party certified to
meet all EPA leak detection standards.

Currently, Leak Detection is approved with two different level probes. However, the same
analysis methods can be applied to tanks gauged with any level measuring device, though no
certification can be provided by FuelsManager. The level probes include:

MTS DDA compatible

Barton Instruments 3500

The certificate rate and required test time are based on the tank size and measuring probe. The
following table shows the gauge types and the corresponding certification parameters.

Gauge Name Tank Volume Cert. Rate Test Time | Max Temp Test Method
Change

MTS DDA - Type 1 0-75,000 gals 0.2 gal/hr 24hrs (+/-)3.6 Volumetric

MTS DDA - Type 2 0-75,000 gals 0.2 gal/hr 24hrs (+/-)0.1 Volumetric

Barton 3500 - Type 1 0-75,000 gals 0.2 gal/hr 24hrs (+/-)6.9 Volumetric

Barton 3500 - Type 2 0-3,000,000 gals 3.0 gal/hr 48hrs (+/-)1.5 Volumetric

Barton 3500 - Type 3 0-3,000,000 gals 3.0 gal/hr 48hrs (+/-)1.0 Mass
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Tank Analysis Types

Note Real-Time analysis can only be configured and performed by an administrator.

The analysis type selected determines the method used to search for a leak. When configuring
a tank, the following analysis types can be set:

Static

Continuous

Real-Time

Static Analysis Type

Note A tank typically requires four hours to become stable for adequate Static analysis.

A Static analysis requires the tank to be shut down (out-of-service) and stable for the time
period or amount of time required for the analysis. Typically, a total of 24 hours of valid data or
quite time is needed to perform a relevant static tank analysis. After analyzing valid historical
data over a minimum 24 hour time period, the system can report valid leak rates.

Continuous Analysis Type

Note Continuous analysis does not analyze tanks in real-time. Like Static analysis, Con-
tinuous analysis is a manual, not automatic, operation.

Continuous analysis allows you to keep the tank in use while performing an analysis. Typically,
a total of 24 hours of valid data or quiet time is needed to perform a relevant continuous
analysis. Continuous analysis should normally be done during a 30 day time period. During this
time, the system identifies valid down times from historical data during regular operation and
builds the results.

Real-Time Analysis Type

Note Only an Administrator or Supervisor can configure and perform Real-Time analysis.

Real-Time analysis allows for an automatic on-going analysis of tanks. Unlike Static and
Continuous types, Real-Time works constantly to analyze the leak rate. A total of 24 hours of
valid data or quiet time is needed to perform a relevant real-time analysis over a 60 day time
period. Tests are performed automatically every day at 12:00 am and at the time defined for
Auto Printing. If the Leak Data alarm is enabled, an alert is given every day at 12:00 am to notify
you that there is not enough valid data or quiet time data from the tank to produce a valid Leak
Test Report. A Leak Rate alarm, if enabled, also notifies you if the calculated leak rate exceeds
the preset alarm limit.

Using Leak Detection

Leak Analysis Tests
As an operator, you can perform two types of leak analysis test:

Static
Continuous

Static and Continuous test methods are tests that have to be initiated by the operator. These
tests are run from the Perform Leak Analysis window utilizing the Run Analysis button.
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Note If configured by an Administrator or Supervisor, Real-Time leak analysis are per-
formed automatically at 12:00 AM and at the time defined for Auto Printing. Consult an
Administrator or Supervisor to configure and perform Real-Time leak analysis test.

To perform a Static/Continuous Leak Analysis Test

1. On the FuelsManager Operate menu bar, select Tools > Perform leak rate analysis. The
Select Tank Point window appears.

Select Tank Paint X

Selected Tank Database > TFME

2. Select a tank, and then click Select. The Perform Leak Analysis window appears.
The selected tank point should appear in the Point Name field. If it does not,

a. Click the ’...” button next to the Point Name field.

b. Select a tank point and then click the Select button. The tank point should appear in
the Point Name field.

Selected Tank Point

Point Marne: ‘ TarkFarm. Tank 1.Tank

System Mame: ‘ VWFME

General

Start Time: 07(27/2005 12:00 AM hd m
End Time: 07j27/2005 12:00 AM -

Properties

Tank Gauge: | Undefined

Tank Analysis Method: | Net Volume:

Tank Analysis Type: |Stat\c j

Results

Leak Rate: aph Elapsed Time: hhimm:ss
Min Yol Used: gal (US)  Min Temp Used: F
Max ol Usad: gal (US)  Max Temp Used: “F

Temp Change: li o

Test Analysis Status

Cancel

3. Select a Start Time and an End Time.

4. Select a Tank Analysis Type. Either Static or Continuous analysis types can be selected
regardless of how the tank point was originally configured from the Edit Tank Point - Leak
Detection page.

5. Click the Run Analysis button to perform the leak test with the criteria selected. The follow-
ing results display in the Test Analysis Status field upon execution: leak rate, elapsed time,
minimum volume, maximum volume, minimum temperature, maximum temperature, tem-
perature change and the test analysis result.
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6. To see a Print Preview, click the Print Preview button. This will display the current results
graphically, as detailed in the ‘Leak Test Report* section. The report can be printed from the
report results window.

The Perform Leak Analysis Window fields and their descriptions are listed in the table below.

Field

Description

Point Name

Used to display the name of the currently selected tank
point. To select a new tank point, press the “...” button
and the Select Tank Point window appears.

System Name

Displays the name of the currently selected DataManager
System.

Start Time Used to select the starting date and time of the leak test.
The Start Time date time picker control defaults to
12:00am today minus the required leak test span for the
tank gauge selected.

End Time Used to select the ending date and time of the leak test.

The End Time date time picker control defaults to
12:00am today.

Run Analysis

The Run Analysis button initiates the leak test analysis
with the current state of the window. The Run Analysis
button is disabled until the Start Time, End Time or the
Tank Analysis Type has changed.

Tank Gauge

Displays the tank gauge that is used in the leak test.

Tank Analysis
Method

Displays the analysis method that is used in the leak
test.

Tank Analysis
Type

Supported types in this field include: Static and
Continuous. Regardless of how the tank was initially
configured, the selection from this field override all
other settings. Defaults to tank point setting.

Leak Rate Displays the resulting calculate leak rate after the Run
Analysis button is clicked.
Elapsed Time Displays the resulting elapsed time of the test after the

Run Analysis button is clicked.

Minimum Volume

Displays the resulting minimum volume after the Run
Analysis button is clicked.

Minimum
Temperature

Displays the resulting minimum temperature after the
Run Analysis button is clicked.

Maximum Volume

Displays the resulting maximum volume after the Run
Analysis button is clicked.

Maximum Displays the resulting maximum temperature after the
Temperature Run Analysis button is clicked.

Temperature Displays the resulting temperature change after the Run
Change Analysis button is clicked.

Test Analysis
Status

Displays the status of the leak test that was analyzed
after the Run Analysis button is clicked.

Print Preview

The Print Preview button will display a report based off
the current leak test result in a preview mode. If the
report needs to be printed, it can be printed from the
Print Preview. The Print Preview button will be disabled
until a leak test has been run.

Cancel

The Cancel button ignores the changes and dismisses
the window.

Varec, Inc.
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Leak Test Reports

Leak Test Reports include the following:

Static Report
Continuous Report
Real-Time Report

Leak Test Report - Static 152004 120710
Tank.1.TankPoint Tank 1
Calculated Leak Rate: -0.087 gph (US) Leak Threshold: 1.500 gph (US)
Test Result: Passed Certification Rate: 3.000 gph (US)
Test Period Start Time: 03/20/2004 0:00 Minimum Temperature: 67.33 °F
Test Period End Time: 03/22/2004 0:00 Maximum Temperature: 67.93 °F
Test Period: 48.00 hour Delta T 0.60 2B
Product Level Used - Stari: 3-02-16 ft-in-16th Minimum Volume Used: 153,850.85 gal (US)
Product Level Used - End: 3-03-00 ft-in-16th Maximum Volume Used: 153,948.92 gal (US)

15413085

154090.88

154042.89

153994 91
g 153946.92 !
'?. 15389894 w '
g 153850.95
>

153002.97

153754.98

153707.00

153859.02 1 1 | 1 1 1 1 1 1 1 1

032004 004 0204 03204 0320104 032004 03104 032104 OXZUDA 032104 OI2M04  0I2D4 Q2N
00:00 0425 0853 1320 7as 2213 az4 0706 133 1600 2026 0053 0520

Static Test Chart (03/20/04 00:00 to 03/22/04 00:00)

k Characte| g

Date Installed: January 01, 1870 Lining Material: EC125U
Tank Radius: 86-00-00 ft-in-16th C ion Material: Mild Steel
Tank Length/Height: 13-00-00 ft-in-16th Cathedic Protection; Yes

Tank Volume: £96,000.00 gal (US) Qverfill Protection: Yes
Automatic Tank Gauge: Barton Model 3500 (Type3) Spill Protection: Yes

Leak Delection System: Version 6.0.0

FuelsManager mec
@ Copyright 2004 Varec, Inc, All Rights Reserved

Figure 10-1: Static Report
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Leak Test Report - Continuous 4512004 12:0815
Tank.1.TankPoint Tank 1
Test Resuit:
Calculated Leak Rate: -3.015 aph (US) Leak Threshold: 1.500 gph (US)
Test Result: Failed Certification Rate: 3.000 gph (US)
Test Data Summary:
Test Period Start Time: 02/22/2004 0:00 Minimum Temperature: 66.99 K
Test Period End Time: 03/22/2004 0:00 Maximum Temperature: 67.83 °F
Test Period: 696.00 hour Delta T 0.94 '
Product Level Used - Start: 11-08-02 ft-in-16th Minimum Velume Used: 163,799.06 gal (US)
Product Level Used - End: 3-03-00 ft-in-16th i Volume Used: 538,798.69 gal (US)
600000
500000 |I l
g 400000
T
-
g 300000
: \
>
200000 \_‘
100000
0 1 1 1 | 1 ! 1 ! 1 1 1 |
0374 0MITI4  031A4  03MED4  03S04  CIMH04  ONINC4  0ITO04 02004 03ITNUD4 0I2ND4 0IZU04  DII4
1035 2018 0601 1545 o1z 111 2055 06.38. 1621 0205 11:48 213 0715
Gontinuous Test Chart (03/17/04 10:35 to 03/22104 00:00)
Tank Characteristics :
Date Installed: January 01, 1970 Lining Material: EC125U
Tank Radius: 86-00-00 ft-in-16th Censtruction Material: Mild Steel
Tank Length/Height: 13-00-00 ft-in-16th Cathadic Pratection: Yes
Tank Volume: $96,000.00 gal (US) Qverfill Protection: Yes
Automalic Tank Gauge: Barton Model 3500 (Type3) Spill Protection: Yes
Leak Detection System: Version 8.0.0

FuelsManager Mec
@ Copyright 2004 Varec, Inc. All Rights Reserved

Figure 10-2: Continuous Report
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Leak Test Report - Realtime

4/15/2004 14.19:24

Tank.1.TankPoint Tank 1
Test Result:
Calculated Leak Rate: -1.949 gph (US) Leak Threshold: 1.500 gph (US)
Test Result: Failed Certification Rate: 3.000 aph (US)
Test Data Summary:
Test Period Start Time: 02/15/2004 13:47 Minimum Temperature: 66.99 °F
Test Period End Time: 04/15/2004 13:47 Maximum Temperature: €8.21 °F
Test Period: 1440.00 hour Delta Te 2.23 °F
Product Level Used - Start: 11-09-02 ft-in-16th Minimum Volume Used: 101,036.75 gal (US)
Product Level Used - End: 2-01-00 ft-in-16th Maximum Volume Used: 538,798.69 gal (US)
600000
500000 |I l
g 400000
: \_‘l
T
£ 300000
: \
>
200000 =
100000 \
o | 1 1 1 1 1 1 1 ! ! ! 1
0317M4 G184 OM1ED4 03104 03104 032004 0JZQ04  DILNOA  DIZHO4 032204 D24 DATIOA 0N
10325 w028 1421 0415 1808 0001 2155 148 0141 535 0528 1821 515
Realtime Test Chart (03/17/04 10:35 to 03/23/04 11:00)
Tank Characteristics :
Date Installed: January 01, 1970 Lining Material: EC1250
Tank Radius: 86-00-00 ft-in-16th Construction Material: Mild Steel
Tank Length/Height: 13-00-00 ftin-16th Cathodic Protection: Yes
Tank Volume: $596,000.00 gal (US) Overfill Protection: Yes
Automatic Tank Gauge: Barton Model 3500 (Type3) Spill Protection: Yes
Leak Detection System: Version 6.0.0
ol
FuelsManager mw
@ Copyright 2004 Varec, Inc. Al Rights Reserved
Figure 10-3. Real-Time Report
Command Description
Tools Perform Leak Rate Analysis Starts the Leak Detection utility
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11 Using the Throughput Calculator

The Throughput Calculator is a utility for calculating and submitting emissions information for
federal Environmental Protection Agency (EPA) requirements.

Note This is an optional feature. This feature is available with FuelsManager Standard or
Professional Editions.

Understanding the Throughput Calculator

Note The Throughput Calculator supports throughput calculations for Federal EPA
requirements. State or local regulations may vary. Please consult the local emissions office
for relevant requirements.

Title V of the 1990 Clean Air Act requires that all major sources of air pollution obtain a new
operating permit. Tank farms and terminals may be a major source of emissions, and as such,
they require a Title V permit.

As a fuel facility operator, you must estimate your site’s total emissions each year. If this
estimate is exceeded your facility can be penalized very heavily. Typically, a software application
developed by the EPA, called TANKS, is used to submit total emissions for Title V applications.
As an alternative, the FuelsManager Throughput Calculator supplies throughputs to TANKS to
reduce the time and effort required by to calculate these values for the purpose of estimating
total emissions.

The Throughput Calculator uses volume increases for an individual tank, which is supplied by
FuelsManager, to calculate the total throughput for a given time range.

Before You Begin

Note In order for the Throughput Calculator to export directly into TANKS software, the
tank names used in FuelsManager must correspond exactly with the names used in the
TANKS software. Varec recommends the naming convention in the TANKS software be
changed to correspond with the naming convention used in FuelsManager.

Please consult an Administrator or Supervisor if there is concern of the current configura-
tion of TANKS.

Using the Throughput Calculator

This section describes how to:

Perform a Throughput Analysis (below)
Update TANKS (“To update TANKS with a Throughput Analysis” on page 106)
Export an analysis to a CSV file (“To export an Analysis to a CSV File” on page 106)

To perform a Throughput Analysis

Note Detailed field descriptions are provided in “Throughput Calculator Field Descrip-
tions” on page 107.
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1.

Start the Throughput Calculator by doing one of the following:
On the Windows Start menu, select Programs > FuelsManager > Throughput
Calculator. The Throughput Calculator appears.

In the FuelsManager Operate window, on the Tools menu, select Throughput Calcs. The
Throughput Calculator appears.

% Standard Edition Throughput Calculator, EJ

Contfiguralion

Auailable Tanks

SAFME
SAFME
SAFME
SAFME
SAFME
SWEME
SWEME

Start Date:
End Date:

Walure Urits:

SystemName | Tank Point ~

TankFarm Tank 1
TankFarm Tank 1
TankFarm Tank 1
TankFarm Tank 1
TankFarm Tank 1
TankFamm, Tark 1

[ Bzrrzos +|

Start Tine: [ 12,0000 804 =

IZEEEE

U.S Gallons =

[
[ |

End Time: ‘ﬂ 5900 PM =

Selected Tanks

System Name | Tank Paint

Add All
v
Remowe All

TankFamm. Tark 1
WEME L Tank 1
< >

System Name:

Tank Point Throughput | Est'early Thioughput | Eng. Units tvald | #

<

Close:

v N W N

Select the Start Date and Start Time for the throughput analysis.
Select the Stop Date and Stop Time for the throughput analysis.
Select the Volume Units to be used in the calculation, display and exported files.

The available tanks in the current archive subsystem will be displayed in the Available Tanks
list. Add individual tanks to the selected list by highlighting the tank in the Available Tanks
list and then either double-clicking or selecting the Add>> button.

Note Remove an individual tank by highlighting the tank in the Selected Tanks list and
then either double-clicking or selecting the <<Remove button. To add or remove all of the
tanks, use the Add All or Remove All buttons.

Click the Calculate button to start a throughput analysis. The same settings will be applied
to all the selected tanks and the results will be displayed in the order the tanks are selected.
The progress of the analysis is displayed in a bar below the Calculated Values list.

After the calculation is complete, see the following sections to update TANKS and/or export
your

To update TANKS with a Throughput Analysis

1.

2.

Perform a throughput calculation as described in “To perform a Throughput Analysis” on
page 105.

Press the Update Tanks button.

To export an Analysis to a CSV File

1.

Perform a throughput calculation as described in “To perform a Throughput Analysis” on
page 105.

After the calculation is complete, press the Export > File button. Enter the file name and
location information when prompted.
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Throughput Calculator Field Descriptions

Fields

Description

Start Date

The start of the date range for the calculation. Selecting
the drop-down arrow opens a calendar for ease of
selection.

Defaults to the current date minus 30 days.

End Date

The end of the date range for the calculation. Selecting
the drop-down arrow will open a calendar for ease of
selection.

Defaults to the current date.

Start Time

The start time for the calculation.
Defaults to 12:00 PM

End Time

The stop time for the calculation.
Defaults to 12:00 PM

Volume Units

Engineering units used for throughput calculation

Available Tanks

Displays available tanks in the current archive system.

Selected Tanks

The tanks that you selected from the current archive
subsystem will be displayed in the Selected Tanks list.

Calculated Values

Shows the results from the throughput calculation. If
multiple tanks have been selected, displays the results

one row at a time as the analysis for a tank is completed.

Calculate

Button that Initiates a throughput analysis. The Calculate
button is disabled until at least one tank has been
selected.

Update TANKS

Copies the calculated throughput value and the selected
date range to the TANKS software.

Export > File/
Abort

If the analysis is complete, the button will be labeled
Export —> File. Clicking this will export the file to a "csv"
formatted file. At the prompt, enter the file name and file
location.

If the Throughput Calculator is analyzing tank data, the
button will be labeled Abort. Clicking this will
immediately abort the current analysis operation.

Varec, Inc.
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acknowledging alarms 16
alarm
line 16
log 22
summary 18
alarms
acknowledging 16
command summary 24

indication 13
managing 13
responding to 15
silencing 15
viewing details 16
B
background color, tank group 44
C
command summary
alarms 24

leak detection 104
product movement 95
reports 57
tank groups 49
trends 67
configuring a tank trend 61
copying a product movement 80
creating
dynamic tank group 40
generic tank trend 65
product movement 78
static tank group 39
custom graphics 51

D

default tank group template 48
details, tank 25

disabling a dynamic report 55
dynamic reports 55

dynamic tank groups 33, 42

E

enabling a dynamic report 55
event log 22

examples, product movement 93
exporting movements 91

F

filter, defining for dynamic tank group 42

filtering, product movement 83

G

generic tank trend 65
generic trend 59, 61

graphical tank group display 33, 44

graphics, custom 51

H

historical trends 59
history, movement 77

importing movements 91
initiating a movement 85, 91
initiating a movement node 85

L

leak detection
command summary 104
reports 102
understanding 97
using 99

leak test reports 102

line, alarm 16

log, alarm or event 22

managing alarms 13
manual overrides 26, 27
meter 70
modifying a movement 86
movement
command summary 95
copying 80
creating 78
displays 81
examples 93
exporting and importing 91
filtering 83
history 77
initiating 85
initiating a node 85
modifying 86
resetting 86
sorting 83
stopping 85
summary 76, 77
tickets 91

N
node 70

o)
opening
generic trend 61
movement displays 77
tank trend 59
time trends 61
opening a tank group 33
Operate, starting 2
overrides, manual 27
overriding tank data 26
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printing a report 56
process variable 44
product movement
command summary 95
copying 80
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display 76, 77
examples 93
exporting or importing 91
filtering 83
initiating 85
initiating a node 85
modifying 86
movement history 77
movement summary 76
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resetting 86
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understanding 69
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real-time trends 59, 61
reports

command summary 57

displaying 53

dynamic 55

leak test 102

printing 56

types 53
resetting a movement 86
responding to alarms 15

S

silencing alarms 15
sorting, product movement 83
starting

Operate 2
static tank groups 33
stopping a movement 85
summary

alarm 18

movement 76

T

tabular tank group display 33, 38
tabular tank group display, changing 45
tank 70

tank calculations, performing 27

tank data, manually overriding 26

tank detail fields 29

tank details, viewing 25

tank group

dynamic
adding 40
defining filter for 42
graphical display
background color 44
changing 44
process variable 44
opening 33
static
adding 39
adding or removing tanks 40
tabular display 45
tank variable, changing 47
template 48
viewing 34
tank groups
command summary 49
display formats 33
dynamic 33
static 33
understanding 33
tank mode commands 31
tank transfers 28
tank trend
configuring 61
opening 59
tank trends 59
tank variable, changing in tank group 47
tanks, adding or removing in group 40
template, tank group 48
throughput analysis, performing 105
Throughput Calculator
understanding 105
using 105
tickets, movement 91
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command summary 67
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generic tank 65
real-time 61
tank 61
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understanding
leak detection 97
product movement 69
tank groups 33
Throughput Calculator 105
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variable, tank 47
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